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I
n my �rst FM column as 

CIMA president in July I set 

out how I wanted to serve 

during this pivotal year in our 

Institute’s history. 

Throughout, it has been a 

privilege to champion CIMA’s 

centenary and our Future of 

Finance research. 

As well as looking forward, I 

have been committed to 

respecting our great heritage. 

Our centenary is an opportunity 

to celebrate what started in 

1919 as a small number of 

leading early 20th century 

businessmen who were 

inspired and had the insight to 

develop a new approach to 

accounting that met the 

demands of manufacturing’s 

new mass production methods. 

The rigorous and robust 

Future of Finance research 

gathered the views of more 

than 5,500 �nance professionals through interviews, 

roundtables, and a large online survey of members 

and students. Globally, its impact has been 

phenomenal. I used the research as a platform to talk 

to members and students — and a range of other key 

stakeholders.

A pivotal year
‘Throughout, it has been a privilege 
to champion CIMA’s centenary and  

our Future of Finance research.’ 

In that �rst July column I 

identi�ed CIMA’s stakeholders 

whom I wanted to engage with 

and in�uence. Top of that list 

have been members and 

students — the future of our 

profession. But I also wanted to 

ensure I could meet with 

employers, academics, 

government representatives, 

regulators, professional bodies, 

and the media to make an 

impact and drive positive 

outcomes for our members, 

profession, and organisation.

Members

Meeting members throughout 

the year has been a great 

privilege — I have encouraged 

and inspired them to be brand 

ambassadors and advocates for 

our quali�cations.

To take one example of 

many, in Dubai I was privileged 

to speak to PepsiCo’s regional �nance team. This 

company has been successful for more than 100 

years and like CIMA has continued to respect its 

heritage while always taking the business to the next 

level. It is well understood that the average lifespan of 

leading companies has dropped dramatically over the 

past 100 years. It is down from 90 years in the 1920s, 

THE VIEW FROM THE PRESIDENT

STEVEN SWIENTOZIELSKYJ, FCMA, CGMA
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The CIMA delegation and Cert. BA students at the 
Gauteng graduation ceremony in Pretoria, South 
Africa, in March 2019.

Taking part in the panel discussion at the CIMA 
Business Leaders’ Summit in Colombo, Sri Lanka, 
in August 2018.

Presenting on the 
Future of Finance in 
London in April 2019.
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according to the London Business School Review, to 17 years today. 

That puts CIMA’s 100-year-long timeline of success clearly into 

perspective.

Further opportunities, in the UK, to meet, listen to, and engage 

with members were in March and April, when I spoke at a series 

of “President’s Roadshows” in major cities. 

Students

My visit to Christ University in India impressed me enormously. 

It is not surprising that a large number of Indian CFOs studied 

there either at undergraduate or masters level. It is di�cult to 

fully comprehend its students’ work ethic — lectures start at 

6.30am and after they end at 5pm, there are music and dance 

activities. Classroom-based study also continues on Saturdays.

The heart of India’s tech industry — its “Silicon Valley” — is in 

Bengaluru (Bangalore). There I presented on the Future of 

Finance to potential students at Wipro, the 160,000-employee 

global information technology, consulting, and business process 

services company. 

Poland has enjoyed continued growth since 1992 — the best 

record of any European country. Our students — and members 

— are part of that success, and it has been valuable to visit and 

meet many of them.

Employers

During the year I engaged with a large number of employers with 

a twofold aim: to build and deepen CIMA’s relationship with 

them and to drive the value of and demand for the CGMA 

designation.

Meetings ranged from small groups of employers, for 

example, an IBM-hosted event in London with ten CFOs, to 

one-to-ones, for example, with the chairman of Deloitte India.

My aim here was to pro�le the Association as the leader of the 

future of �nance space and as the expert in de�ning the future 

skills and competencies for tomorrow’s �nance professionals.

Academics

A part of my work this year has been to 

build advocacy amongst academics for 

our quali�cations and CIMA 

membership. Engaging with this key 

audience on the Future of Finance 

research has been an important strand of 

work and highly instructive all round. One highlight was taking 

part in a very lively academic roundtable in Auckland. Scheduled 

for two hours, it was still going strong after three and a half.

Government representatives, regulators, and 

professional bodies

Sri Lanka is one of our larger markets. I was pleased to attend 

CIMA’s annual �agship event there: the Business Leaders’ 

Summit, which attracts a large number of senior business 

leaders. A government minister acknowledged in a speech there 

that CIMA had been instrumental in the development of the Sri 

Lankan economy. I also met other key �gures in the Sri Lankan 

government and was able to discuss a range of issues.

Media

Engaging with the media is on the agenda of any CIMA president 

to build awareness of who we are. For me, this has meant 

interviews with a diverse range of media including the popular 

UAE Arabic-language newspaper Al Bayan; the Manchester 

Evening News in the UK; Poland’s national daily economic and 

legal newspaper Rzeczpospolita; and television interviews in 

Botswana and Canada.

I have embraced social media, too. By the end of my year as 

president I will have completed ten Facebook Live videos and 

reached an audience in the hundreds of thousands.

Final thoughts

On a personal level, the year has been both challenging and 

rewarding. CIMA’s great history, born out of the early years of 

mass production, is an example to many of how an organisation 

can ride the waves of economic, social, and technological change 

and emerge with strength for long-term success. 

I believe organisations need to innovate to survive and thrive. 

The same is true for individuals — we need what psychology 

professor Carol S. Dweck, Ph.D., describes as a “growth mindset”, 

which leads to a desire to learn and an ability to confront and 

surmount obstacles. Finally, I want to quote industrialist and 

philanthropist John D. Rockefeller’s challenge: “It 

requires a better type of mind to seek out and to 

support or to create the new than to follow the 

worn paths of accepted success.”  ��Q

Lighting of the traditional oil lamp at 
the CIMA convocation in Colombo,  
Sri Lanka, in September 2018.

Meeting Sri Lankan Prime Minister Ranil 
Wickremesinghe (far right) and International 
Chamber of Commerce India president 
Jawahar Vadivelu (middle).

Speaking at the CIMA 
President’s Centenary Dinner 
in London on 8 March 2019.
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O
ne hundred years ago, CIMA 

was founded by a group of 

forward-looking 

businesspeople. Their 

intention was to transform the 

accountancy profession into one that 

would support them in managing and 

leading their businesses.

Early on, there was a strong link with 

engineering. “Mechanical knowledge” 

was the title of a paper in the �rst  

Institute exam in 1920, and our early  

vice-presidents represented key industry 

segments including steelmaking, cotton 

spinning, car manufacturing, and printing.

The initial work of the Institute was 

around cost management: The period up 

to the late 1930s can be described as the 

development of costing as a science. It 

culminated in the publishing in March 

1937 of “Costing Terminology” in The Cost 

Accountant, the Institute’s journal. 

Over the century we have continued to 

lead on cost management and evolve it 

into the concept of value creation. The 

journey has taken us through cycles of 

automation, the evolution of risk 

management, tools such as balanced 

scorecards, and frameworks such as 

activity-based costing. Our history is 

contained in Leading the Transformation 

— 100 Years and Beyond, written by the 

Association’s Martin Farrar, Ph.D., which I 

commend to you (available at tinyurl.com/

yymzsnrq).

In October 1950 this journal 

announced that an Institute team was to 

visit the US to investigate the use of 

costing information through the  

Anglo-American Productivity Council. It 

marks the point when management 

accounting entered the lexicon of our 

Institute and its members. It is clearly an 

important evolutionary step in CIMA’s 

route of progress throughout the past 

century. Today, management accounting is 

recognised as the essential part of 

“decision support”, and management 

accountants work alongside business 

leaders and managers as trusted and 

objective partners.

Over the years, we have added value to 

business. We have also provided 

opportunities for people across the world 

to have rewarding and satisfying careers. 

Our members have made a di�erence not 

only to the businesses they work for but 

also the communities they live in.

Today, CIMA continues to lead in the 

accounting profession. As a founding body 

of the Association of International 

Certi�ed Professional Accountants, we are 

driving a global management accounting 

profession, creating value for businesses 

and the proud individuals who make up 

our profession.

Going beyond our centenary, we 

anticipate change on a scale and at a speed 

we have not experienced before. However, 

with our updated CGMA Competency 

Framework, the 2019 CIMA Professional 

Quali�cation Syllabus, and our growing 

suite of CPD programmes, we are 

equipping our members to thrive in that 

digital future.

As work becomes increasingly 

technology-enabled, I believe the 

management accountant’s role will 

become even more critical to the success 

and longevity of organisations. Canadian 

historian Margaret MacMillan neatly 

makes the case for learning from the past. 

“History can help you … to make sense of 

your present situation; to remind you that 

there were other situations like it in the 

past; and to help you formulate the right 

questions.” I believe learning from past 

experience can prepare you to bring order 

quickly when faced with the ever more 

complex scenarios that accelerating 

change in business brings.

Our members’ roles are increasingly 

about asking the right questions that can 

lead to better decision-making.

 Our Association will also continue to 

ask the right questions and continue to 

invest in our ability to provide learning 

and career support for our members that is 

relevant and of high quality. That learning 

means they can continue to lead their own 

organisations to even greater success.   

Learning 

from the past
By Andrew Harding, FCMA, CGMA

Andrew Harding, FCMA, CGMA,  

is chief executive—Management 

Accounting, at the Association of 

International Certified Professional 

Accountants.
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Map your route to success. 
You are your best investment.

As accountants in practice, we know the importance of 

keeping our skills fresh. The more we improve individually, 

the better our business performance will be. 

Run by members for members, the 2019 CIMA Members in Practice 

Conference is tailored to provide maximum value to you — whether 

you’re in a large firm, a small and medium-sized enterprise, or 

looking to start your own practice. 

Currently in its 34th year, the conference will give you the tools to 

run your business to the best it can be. You’ll gain valuable CPD, 

networking opportunities with other members in practice, and 

tangible skills that you can apply in your business the very next day.

When  
21 June (Friday)  

and 22 June (Saturday),  

9am–5pm 

A black-tie gala dinner  

will be held on Friday night.

Where   
Woodland Grange,  

Old Milverton Lane,  

Leamington Spa,  

Warwickshire CV32 6RN

What will you learn   
Learn from expert presentations, 

seminars and exhibitions on the 

following: 

 Technical updates  

 Sales and marketing 

 Software advice 

 Technology 

 Soft skills  

 CIMA support and initiatives 

Upskill yourself — book  

your slot today. Visit  

cimaglobal.com/MiP2019 

for more details and 

registration information.

now

WOW

1902-2833_1_MiP Conf_FM house ad_200x266mm_CMYK_FINAL.indd   1 26/02/2019   15:08



INFO ROUNDUP

What China is 

doing in Africa

Researchers at the China-Africa 

Research Initiative at Johns 

Hopkins School of Advanced 

International Studies argue in 

a policy brief that China’s 

rising labour cost and slowing 

growth are behind Chinese 

manufacturers’ move to shift 

production lines to Africa. 

They found four kinds of 

Chinese companies in Africa:

Companies seeking raw 

materials. Raw minerals 

usually are exported to 

wealthier countries for 

smelting and re�ning. 

Companies with global 

supply chains. Tanzania and 

Ethiopia are home to Chinese 

garment and shoe 

manufacturers. These 

labour-intensive industries 

often o�shore production 

lines. 

Companies seeking 

strategic local markets.  

For example, a Chinese 

agrochemical producer 

purchased a Ghanaian 

company to expand its African 

sales channels.

Opportunistic small 

companies �ocking 

together. These are small-scale 

manufacturers clustering in an 

industrial zone. 

Australia finance job 
vacancies, 
salaries 
on the 
rise
In the face of �nance systems automation and 

o�shoring and outsourcing trends, demand is 

rising for quality �nance and accounting 

workers who can provide value-added services 

to �nance teams and direct �nance 

transformation in Australia, according to a 

recent report by recruitment �rm Michael Page.

Australia Salary Benchmark 2019 revealed 

that the past year has seen a 21% increase in the 

number of �nance and accounting jobs posted. 

Average salaries for these positions increased 

between 5% and 10% for workers who switch to 

a similar job. The top industries hiring for 

�nance and accounting roles include fast-

moving consumer goods and retail; healthcare 

and pharmaceutical; industrial and 

manufacturing; property and construction; and 

the public sector.

“Since the global �nancial crisis, there’s 

been a push for cost savings in Australia. We 

saw a number of �nance teams move their 

�nance functions — usually the more 

transactional teams — to di�erent parts of 

Asia,” said Sung Ho Lee, director of �nance, 

legal, and sales at Michael Page Australia.

To support the transformation of �nance 

functions, roles such as �nance project 

manager and head of transformation are in high 

demand, with an average salary of  

AUD 160,000 ($114,000) and AUD 205,000 

($146,000), respectively, according to the report.

Automation and o�shoring are also 

changing employers’ expectations. Companies 

in Australia now expect �nance workers to 

perform more higher-level work than before, 

such as providing decision-making analysis in 

addition to traditional �nancial reporting tasks. 

Trending skills in job descriptions re�ect this. 

Buzzwords include business partnering, big 

data, and analytics skills.

“The biggest challenge for �nance 

professionals is the growing need for digital 

and technical skills, and the need for swift 

adaptation to the rapidly changing �nance 

roles,” said Devika Mohotti, CPA (Australia), 

FCMA, CGMA, national sales operations 

manager at Schneider Electric in Sydney. 

“While some roles disappear, new roles 

continue to emerge and evolve. Unlearning is 

also an essential skill to adapt to [the] changing 

environment.”

— By Alexis See Tho (Alexis.SeeTho@ 

aicpa-cima.com), an FM magazine associate 

editor.
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230,000
People who paid the €9 

entrance fee to ascend to the 
viewing platform of 

thyssenkrupp’s 246-metre 
tower in the first 12 months 

after it was built.

Full story, page 42

Just fix it
‘If you have a problem now,  

why don’t you fix it now?’ 

— Paul Polman, chair of the International 

Chamber of Commerce and former CEO of 

Unilever, said on the lack of equal pay  

for men and women.

Full story, page 28

1.3 

million 
The approximate 
number of annual 
individual patient 

contacts at Nottingham 
University Hospitals in 

the UK.

Full story, page 22

PepsiCo Indonesia CFO: 

How I drive the 
business 
While well known for its soft drinks, PepsiCo is more than a 

beverage company. It also owns the Frito-Lay and Quaker Oats 

brands. In 2017, it was the third-largest food and beverage 

company in the world with global sales of $96.5 billion, behind 

Nestlé and the Coca-Cola Company.

Seven years ago, Dhianendra Laksmana, ACMA, CGMA, said 

yes to an opportunity of a lifetime to head the �nance function 

of PepsiCo Indonesia as its CFO. Laksmana shared 

with FM magazine how he drives PepsiCo Indonesia’s 

businesses. Edited excerpts follow.  

You’ve been a �nance manager and head of �nance before 

becoming a CFO. What is a key di�erence you see in your 

role as CFO?

I think the main di�erence is that a CFO is more than just a 

�nance head — you are expected to drive the business. 

Obviously, you ensure the delivery of �nancials, but the bigger 

objective is to work with the CEO to drive the business, drive 

performance. One goal that perfectly summed [up] the CFO’s role 

was [what] my boss told me when I �rst came and took on the 

role. He said, “Your objective is to try to replace me. Think like 

me and help me drive this business.”

For instance, I’m the one in charge of pro�t and loss 

forecasting. But forecasting will only be on paper. Any �nance 

manager can do forecasting, but driving the business is making 

sure that the forecasted commitment is being carried through.

Can you give an example of delivering the forecasted 

numbers?

We have monthly rolling forecasts. First, what we do is bottom 

up — get the input from sales and marketing. In most cases, that 

is not what we will �nally submit because there may be 

top-down targets that need to be met, or the bottom-up targets 

are more than what we need to deliver. 

Then you have to go to the details line by line — how we can 

achieve this target? In the channels, I see where we can go, 

where we can push more. They might say it cannot be done. So I 

will look at the historical numbers and say, “You did this without 

any promotional campaign. Now if you need to do the same, 

what do you need, how much [revenue] can we add if I give you 

more money for promotions?” 

What is a challenge for your role?

We are responsible for overall Indonesia delivery. The main 

challenge is how to drive the business with the di�erent kinds of 

set-up. We have to work with the bottling partner, [but] we’re not 

the one who owns the sales team, we’re not the one who owns 

the manufacturing, and [bottlers] have their own goals. We have 

to align their goals with ours to get our objectives. 

— By Alexis See Tho (Alexis.SeeTho@aicpa-cima.com), 

an FM magazine associate editor.
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CIMA history It took many steps to reach 
CIMA’s centenary. Here are 
some of the key ones:

1919 1937 19721920 1942 19751921 19551936 1969

The Institute of Cost 
and Works Accountants 
(ICWA) is founded, with 
37 members by the end 

of 1919. Entrepreneur 
Lord Leverhulme 

becomes the Institute’s 
first president in 
December 1919.

 

The first female 
member, 

Miriam Neale, is 
admitted to the 

Institute. 

“Costing 
Terminology”, which 

established the 
science of cost 

accounting until the 
mid-1970s, is 

published in The Cost 

Accountant, the 
Institute’s journal.

 

First 
international 

office opens in 
South Africa.

The first 
examination is 

held in 
December.

The number of 
active members 
reaches 1,000.

First Institute 
exams sat by 

British servicemen 
being held in 
Germany’s 

prisoner-of-war 
camps.

The Institute 
appoints an 

Overseas Affairs 
Committee to 
advise on its 

development “as 
an international 

body”. 
The Institute is 
granted a Royal 

Charter.

 

The Institute 
changes its 
name to the 

Institute of Cost 
and 

Management 
Accountants.
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The number of 
active members 
reaches 50,000.

 

The Institute 
changes its 
name to the  
Chartered 
Institute of 

Management 
Accountants.

 

The Chartered 
Global 

Management 
Accountant 

(CGMA) 
designation is 
introduced in 
partnership 

with the 
American 
Institute of 

CPAs.

Examinations 
move to 

computer and 
on demand.

The number of 
active members 

reaches 
100,000.

CIMA members 
are given the 

right to use the 
title  

Chartered 
Management 
Accountant.

The Institute 
elects its first 

female 
president, 

Claire Ighodaro.

The CGMA 
Competency 

Framework is 
published.

The Global 
Management 
Accounting 

Principles are 
launched.

The Association 
of International 

Certified 
Professional 

Accountants is 
formed on  

1 January with 
more than 

650,000 
members in 177 

countries.

 

The 2019 CIMA 
Professional 
Qualification 
Syllabus and 

updated CGMA 
Competency 

Framework are 
launched.
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The Roman marble statue 

of Antinous, dating to circa 

130–138 AD, stands in a 

rotunda of the Lady Lever 

Art Gallery.
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CIMA’s first president, Lord Leverhulme, 

built a gallery to share his personal art collection. 

By Oliver Rowe

A
rt has always been to me 

a stimulating in�uence; 

it has always taught me 

without upbraiding me; 

elevated me without 

humbling me; and appealed to me 

because of the fact that only the best 

and truest in art survives.”  

 These were the words of Lord 

Leverhulme — entrepreneur, 

philanthropist, and CIMA’s �rst 

president in 1919 — at the opening of 

the Lady Lever Art Gallery in 1922 in Port 

Sunlight Village in Merseyside in the 

north-west of the UK.

Now part of National Museums 

Liverpool, the neoclassical-style gallery 

was dedicated to Leverhulme’s wife, 

Elizabeth, who died in 1913. The gallery 

displays large parts of Leverhulme’s 

largely British-focused 20,000-piece 

collection — paintings, sculpture, 

furniture, ceramics, and textiles. 

Particularly strong is its collection of 

19th-century Pre-Raphaelite paintings 

as well as pictures by Thomas 

Gainsborough, George Stubbs, John 

Constable, and J.M.W. Turner. There is 

also a major collection of Wedgwood 

jasperware — a type of coloured pottery.

Leverhulme’s company, which 

eventually became Unilever after 

merging with Dutch oils and fats 

company Margarine Unie in 1929, 

started producing Sunlight soap in 

1884. Three years later weekly output 

was 450 tonnes of the individually 

wrapped bars of soap. That year, 1887, 

he also bought a site — which he 

named Port Sunlight — for a new 

factory and a high-standard, purpose-

built village with leisure facilities for its 

workers.

Today, Port Sunlight Village’s 900 

buildings, including the Lady Lever Art 

Gallery, are Grade II-listed — in a 

protected category on the UK 

government’s National Heritage List for 

England, which means there is control 

over the changes that can be made to 

the buildings’ interiors and exteriors. 

Leverhulme’s provision of better 

housing for his employees is widely 

considered a long-term success — it 

Art   for all

wasn’t until the 1980s that Unilever began to 

sell o� the houses and lifted the restriction 

that only employees could live there. 

The art gallery’s collection can be explored 

at tinyurl.com/y8vb49x2 or on the Lady Lever 

Art Gallery app available on the Apple App 

Store. In addition to Leverhulme’s passion for 

art was a steadfast belief in the importance of 

strong accountancy to business. In his 

foreword to the �rst issue (June 1921) of The 

Cost Accountant, the o�cial journal of the 

Institute of Cost and Works Accountants, as 

CIMA was known then, he wrote: “What the 

compass is to the mariner under modern 

conditions of navigation as compared with 

steering by stars or by sight under old-world 

time conditions so is an e�cient cost and 

works accountancy system to modern 

conditions of commerce.” 

“

Oliver Rowe is an FM magazine senior 

editor. To comment on this article or to 

suggest an idea for another article, 

contact him at Oliver.Rowe@ 

aicpa-cima.com.



The skills of CIMA’s members have helped the Institute survive war, 

thrive in peacetime, and prepare for the future. 

By Ken Tysiac

Standing the test of   time 
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W
hen any organisation 

reaches a milestone 

anniversary, it’s easy to 

look back through 

events in its history and 

see what’s truly important to its people.

This is certainly the case with The 

Chartered Institute of Management 

Accountants, whose history is chronicled 

and celebrated in rich detail in Martin 

Farrar’s book Leading the Transformation: 

100 Years and Beyond.

The publication by Farrar, Ph.D., an 

associate technical director–Management 

Accounting at the Association of 

International Certi�ed Professional 

Accountants, is available as a free PDF 

download at tinyurl.com/yymzsnrq. The 

text shows that from 1919 to the present 

day, CIMA members have displayed:

yyy Commitment to principles that 

promote success in business.

yyy Zeal for rigorous professional 

standards, knowledge, and 

professional development.

yyy Dedication to precision, truth, and 

impartiality.

yyy A focus on building a successful 

international Institute.

The book contains countless anecdotes 

detailing the many accomplishments of 

CIMA and its members, from the 

f   time after 100 years

FM-MAGAZINE.COM  June 2019  I  FM MAGAZINE  I  17

The Institute’s coat of arms, shown here annotated on a wall 
in the CIMA office in London, has evolved over the years to 
incorporate symbols that represent the work of its members.
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organisation’s modest beginnings 100 

years ago through its emergence as a 

global force in management accounting. 

Here are summaries of just a few 

highlights.

Objects with staying power

The Institute of Cost and Works 

Accountants, as CIMA originally was 

known, was established in 1919. In 

February of that year, seven individuals 

who had discussed the possibility of 

forming an association agreed to the 

principal objectives of the Institute.

The objectives were part of a 

Memorandum of Association that 

explained the seven signatories’ desire to 

join forces. The objects were:

yyy To provide an organisation for cost 

accountants, works accountants, 

estimating and cost clerks, and 

others engaged in occupations 

requiring a mathematical and 

technical knowledge of industry in 

all its branches, embracing in such 

knowledge as the cost of production, 

manufacture, or sale of all articles 

produced, manufactured, or sold, in 

Podcast: Small 

beginnings, big impact

An idea hatched by a small group of 
accountants led to the formation of 
an organisation that has become 
highly influential and known 
throughout the world for its profound 
effect on management accounting. In 
this podcast, Martin Farrar, Ph.D., 
author of Leading the Transformation: 

100 Years and Beyond, talks about 
some of his favourite moments in 
CIMA’s history. To listen to the 
podcast, “CIMA’s History —  
The Route to 100 Years”, visit 
fm-magazine.com/cimahistory.
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order to secure for them a de�nite 

professional status by means of a 

system of examinations and the 

issue of certi�cates of competency.

yyy To promote and protect the mutual 

interests of members and as far 

as possible assist them to obtain 

adequate remuneration for their 

services.

yyy To assist necessitous members and 

to raise, manage, and apply any fund 

for this purpose.

yyy To form a library for the use of 

members.

yyy To a�ord the members the bene�ts 

of a club.

One hundred years later, these 

principles are alive and functioning in 

CIMA. The organisation continues to 

maintain an examination process to certify 

competency, and this year it issued an 

updated version of the CGMA Competency 

Framework. The framework is designed to 

help management accountants, �nance 

professionals, and their employers 

understand the knowledge requirements 

and assess the skills needed for the roles 

they occupy today and the positions they 

hope to �ll in the future.

 

The early industrialists

The story of industrialist Lord Leverhulme, 

who was appointed the Institute’s �rst 

president on 2 December 1919, is well 

known. Leverhulme was co-founder of 

Lever Brothers, which originally 

manufactured a product known as Sunlight 

Soap and later became part of Unilever.

However, he was hardly the only 

prominent early industrialist to hold an 

important role in the �edgling 

organisation for accountants. Well-known 

vice-presidents of the Institute at the time 

included:

yyy Sir Robert Had�eld, a metallurgist 

from She�eld who discovered and 

invented the manganese-steel and 

low-hysteresis processes. 

yyy Sir Charles Wright Macara, who 

was famed for his Lancashire 

cotton-spinning factories.

yyy Sir Herbert Austin, founder of 

the Austin Motor Company, who 

also had been a manager and then 

became chairman of the Wolseley 

Sheep Shearing Machine Company.

yyy Walter Howard Hazell, chairman of 

the Federation of Master Printers.

Contents of the early syllabus

An examination of the early syllabus of 

the Institute shows that the required 

learning topics were diverse. The �rst 

examinations based on the Institute 

syllabus took place in December 1920, and 

an early syllabus from October 1922 shows 

that at the preliminary level, exam 

candidates were assessed on:

yyy Mathematical concepts including 

plane geometry, simultaneous 

algebra equations, ratios, proportion, 

and percentages.

yyy The ability to translate an easy 

passage from a foreign language 

into English, although this skill was 

optional.

yyy An English essay.

yyy Bookkeeping related to the 

presentation of a balance sheet.

yyy Elementary mechanics, covering 

topics such as work, friction, levers, 

gearing, and various forms of 

motion.

The intermediate and �nal levels of the 

examination process required deeper 

knowledge of subjects such as economics, 

costing, workshop knowledge, and 

advanced bookkeeping and legal issues. 

Female pioneers

Miriam Sarah Neale was admitted as the 

Institute’s �rst female fellow in March 

1921. She was recorded as member 

number 272 in the �rst book of members 

and had a long and successful career in 

business and accounting. 

She spent the early part of her working 

life with an engineering company and 

began work as a cost accountant at the 

pharmaceutical manufacturer Allen & 
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Hanburys Limited in 1917. She was 

promoted to chief cost accountant in 1923, 

and 25 years later she began serving as a 

director of Penplas Industries Limited, 

which made low-cost fountain pens.

Annie Alice King became the 

Institute’s second female fellow in June 

1924. She was head cost accountant at St. 

Clement’s Press Limited, which printed 

the Financial Times newspaper. King 

spent most of her career in the paper and 

printing trades.

The �rst female Institute Council 

Member was elected in September 1980. 

Denise Jenkin represented Area number 

10, The Republic of South Africa. She had 

served as head of the accounting 

operation at an electrical/mechanical 

engineering company and as group 

accountant/company secretary for a large 

international citrus company before 

starting her own computer bureau in 1974.

In 2003, Claire Ighodaro’s election 

represented a milestone on two fronts as 

she became the Institute’s �rst female 

president and its �rst black president. At 

that time, she was �nance director, 

broadband, at BT.

“It’s nice to look back and see that 

things have changed and that there are 

opportunities for everyone,” she said in 

2003. “A lot of it is down to how you 

approach matters. Things are di�cult 

because you think they will be. If you 

want to do it, just get on with it.” 

Chartering a royal course

The Institute �rst raised the issue of 

pursuing a Royal Charter in 1919, but the 

cause initially was abandoned because of 

its cost. Four years later, the Institute 

announced at its annual general meeting 

that it had applied for a Royal Charter.

Ronald Smith, Barrister-at-law, 

described the importance of a Royal 

Charter in an article in The Cost 

Accountant: “The grant of a Royal Charter 

at the present day constitutes a 

recognition by the highest authority that 

the public welfare is concerned in the 

The Institute had pursued a Royal Charter of Incorporation 
starting in 1923. The dream finally came to fruition when the 
Queen in Council approved the grant on 13 February 1975. 
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Ken Tysiac is FM magazine’s editorial 

director. To comment on this article or 

to suggest an idea for another article, 

contact him at Kenneth.Tysiac@

aicpa-cima.com. 

activities and the prosperity of the body to 

whom the charter is granted.”

Partly because of opposition from 

several societies and the Institute of 

Chartered Accountants in England and 

Wales, the �rst application for a Royal 

Charter was not granted. But more than 50 

years later, the dream of receiving a Royal 

Charter became a reality.

The Queen in Council approved the 

grant of Royal Charter of Incorporation to 

the Institute on 13 February 1975.

“Every ICMA member and every student, 

here and in many countries abroad, will 

take pride in this, the most momentous 

point in the Institute’s history,” Institute 

President Denys Edmonds said at the time. 

“It ought to be a matter of pride, too, to the 

whole profession.”

An international accounting body

The �rst reference to o�cial Institute 

representation outside of Great Britain 

was an announcement in the Institute’s 

journal in 1922 that Charles F. Treeby, 

ACWA, was appointed honorary 

representative of the Institute for India.

The international character of the 

Institute grew steadily, and by 1971 the 

organisation had members in 87 countries 

around the world, and students could take 

Institute exams at 92 centres across the 

globe.

Now, of course, CIMA has members 

and o�ces all over the world. 

Probity, accuracy, justice

The new armorial bearings and badge of 

o�ce of the Institute were granted in 

October 1932 under letters patent by the 

Royal College of Arms. The motto, using 

the Latin words for “Probity, Accuracy, 

Justice”, was selected to evoke the spirit of 

service displayed by the Institute and its 

members.

Symbols on the coat of arms that 

visually represent the work of the 

Institute and its members include:

��y Callipers, which symbolise precise 

measurement.

��y A book, denoting reading and 

interpretation.

��y Scales, representing truth and 

impartiality.

��y The sun’s light shining on bees 

(representing industry), gold coins 

(commerce), and a wheatsheaf 

(agriculture).

In 1953, a pair of lions was added to the 

coat of arms. One lion carries crossed tally 

sticks, which represent the ancient 

method of accounting. The other carries 

an hourglass, which symbolises the 

measurement of time. Wheels at the foot 

of each lion are representative of industry.

War and the cost accountant

Cost accountants were in high demand 

during World War II because they were 

viewed as the linchpin between 

manufacturing �rms and government 

departments. At a time when every 

resource was immensely precious, costing 

was seen as extremely valuable because of 

its role in maximising production 

e�ciency.

The report from the annual general 

meeting in 1942 noted that: “The Institute 

has done and will continue to do 

everything possible to co-operate with all 

concerned in this matter. The Institute 

has co-operated with the Ministry of 

Labour and National Service, and other 

government departments, in all matters 

a�ecting the provision of suitably 

experienced members.”

The war hit close to home on 9 

September 1940, when the Institute 

headquarters located at Number 23, 

Queen Square, London, WC1, was 

damaged in a German air raid. High-

explosive bombs directly hit two 

buildings adjacent to the Institute’s 

headquarters, causing damage to the 

Institute’s building as well.

The incident caused Council to agree to 

move Institute functional activities back to 

Links View, Sandy Lane, Kingswood, 

Surrey. In 1944, however, the Institute’s 

temporary headquarters 20 miles outside 

of London also received super�cial damage 

from German rockets that were aimed at 

London but went astray.

Meanwhile, 99 of the Institute’s 1,366 

members and approximately 881 of the 

Institute’s registered students were 

attached with HM Armed Forces at the 

beginning of 1941. Incredibly, thanks to 

arrangements by the International Red 

Cross and the University of London, the 

Institute was able to hold examinations 

for prisoners of war held in Germany.

CIMA at 100

On its 100th anniversary, CIMA is a vibrant 

international organisation that remains a 

credit to the objectives laid out by its 

founders. CIMA’s headquarters are located 

in the heart of London’s �nancial centre, 

and the 2019 edition of its CGMA 

Competency Framework has been 

expanded in response to the emergence of 

new digital skills that management 

accountants and �nance professionals 

will need to know to continue succeeding 

in their current positions as well as the 

roles they will �ll in the future.

In 1925, upon his appointment as the 

second president of the ICWA, Walter 

Howard Hazell said: “If the enthusiasm of 

the members of the Institute meets with 

its just reward, and their ideals are 

attained, it will become a great and 

important body in the commercial life of 

the country, and industry will have 

bene�ted enormously by the activities of 

the members and the same principles 

they have advocated.”

One hundred years after its founding, 

CIMA has met and even surpassed those 

lofty ideals as an important body in the 

commercial life of the world as well as 

the UK. The vision of the Institute’s early 

leaders has been realised, and today’s 

members continue to advance the 

organisation’s mission into the future 

— in an uncertain time when a 

management accountant’s skills are as 

valuable as ever.   Q



You can 

make a 

difference.

For a century, CIMA members have transformed organisations, communities and
economies. They also transform individual lives through donating to the CIMA Benevolent 
Fund. During our 100th year, let's continue to help one other while driving the future of the
profession.

To mark CIMA’s 100th year and ensure our future, we are sharing a
limited-edition CIMA Benevolent Fund card at Centenary events. We hope 
this card reminds you, our valued member, that you are supported — and 
can support others.

To learn more about the CIMA Benevolent Fund,
go to cimaglobal.com/benevolent100
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The UK’s National Health Service uses data to seek 

better patient outcomes while maximising efficiency.

By Rebecca McCaffry, FCMA, CGMA

O
ne hundred years after the founding of CIMA as the 

Institute of Cost and Works Accountants, the 

principles and practices used by cost accounting 

professionals at the UK’s National Health Service are 

very similar to those used in 1919 (see the sidebar 

“Cost Accounting Took Slow Route to Appreciation”). Although the 

cost accountant of 1919 might be confused by the technology used 

today, the tactics of the past have a prominent role at Nottingham 

University Hospitals (NUH), which provides services to more than 

6 million people across the city and the region beyond and is 

recognised as a leader in healthcare cost transformation. Leading 

the charge are operational director of �nance Duncan Orme and 

head of costing Scott Hodgson, ACMA, CGMA, both of whom are 

involved in healthcare costing on a national level.

Bringing value

to healthcare
using cost accounting
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A 2014 CIMA report, Building Clinical 

Engagement With Costing, found that 

costing was generally viewed by 

clinicians as a support function, with 

engagement between costing and clinical 

teams limited to business case 

development. In recent years, however, 

clinicians have begun to realise the 

importance of cost information for 

decision-making, and the pro�le of 

healthcare costing has seen signi�cant 

promotion. Attendance at the Healthcare 

Financial Management Association’s 

2018 Clinical Forum saw doctors 

outnumber cost accountants for the �rst 

time, and a growing number of clinicians 

are speaking about costing at national 

conferences, further raising awareness 

amongst their peers.

Changing the image of cost 

accounting

While the raised pro�le of costing is 

welcome, Orme sees a danger that the 

demand for experienced cost 

accountants is beginning to outstrip 

supply. He believes cost accounting’s 

image needs a makeover and that the 

way to achieve this is to highlight the 

importance of the cost accountant’s 

skillset to the wider healthcare system.

“One key motivation in our roles, 

both as practitioners and as 

in�uencers on the national scene, is to 

promote interest in how you can, 

e�ectively, become a member of a 

clinical team, working with the 

clinicians in a healthcare environment 

to improve the value and outcomes of 

healthcare,” he said.

Management accounting techniques 

that were once used in the factory 
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setting are now being used to develop 

patient insights and deliver better 

healthcare outcomes.

Datasets

Hodgson explained the impact that the 

growing volumes of data and information 

have had on his role. 

“The amount of data and information 

we have and the meetings we attend about 

the information has really evolved,” he 

said. “When we started PLICS [patient-level 

information and costing system] in 2010, 

we had two or three information feeds. 

We now have over 70 feeds pulled into the 

system, and so far we have delivered £20 

million of savings.”

NUH sees approximately 1.3 million 

individual patient contacts per year, the 

equivalent of 1.3 million product lines. 

The NHS system uses a national tari� 

payment approach to cost reimbursement 

for healthcare providers based on 

organisation-level average cost data. This 

means that for each patient contact, the 

team is able to create an individual 

income and expenditure account showing 

details of day-to-day care, with an average 

of 150 data items per subject. On any 

given day, sta� can see how money was 

spent on patient care.

Hodgson explained the process. “We 

work hard on our visual presentation of 

this for the clinicians, using red or green 

bed days to distinguish those days when 

no diagnostic or therapeutic activity has 

occurred. Clinical teams can see what’s 

happening at an individual patient level 

and the impact that delays in diagnosis or 

discharge have when the breakeven point 

has passed and the patient is making a 

loss for us,” he said. 

“We aggregate this up and take a look at 

pathways of care, to see how we can 

redesign services to promote better care 

pathways. And that’s where the 

transformation comes. We are no longer 

cost accountants; we are transformation 

and cost accountants. 

“Understanding cost and 

understanding what goes into cost is not 
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the same as rationing. It’s making sure 

that we make healthcare sustainable 

through that understanding.” 

Bedside data capture

NUH uses “Nerve Centre”, a bedside 

capture system using iPads or iPhones to 

record interactions with patients. Each 

day is tagged as red or green, recording 

whether an activity that leads towards 

discharge has been undertaken. This 

enables bottlenecks to be identi�ed and 

addressed. “It’s really not the costing that 

does this,” Hodgson said, “but the input 

information that we pull into the costing 

system that helps the users. We cost by 

the day so we can see the cost of a red day, 

the cost of a green day. We can ask, ‘Why 

did that red day happen?’ ” 

Red days require reason codes for 

delays; for example, “waiting for radiology 

test”, “waiting for pathology results”, or 

“waiting for a community care bed”. These 

codes can be played back to the clinicians 

who are using the system. In e�ect, the 

system is a supply chain, and the 

information collected helps the costing 

and clinical teams to look not just at one 

aspect but how it impacts or is impacted 

by the services around it. 

Queen’s Medical Centre is part of Nottingham University Hospitals,
 which provides services to more than 6 million people.
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Data for diabetes

One of the ways in which hospital data 

are being used proactively across the 

healthcare system is illustrated by the 

work Hodgson’s costing team has 

undertaken with local general 

practitioners. Data relating to a cohort of 

diabetes patients were shared and 

analysed to help medical professionals 

serving as consultants understand 

whether patients presenting at major 

hospitals are self-managing their 

diabetes e�ectively or will require 

stabilisation before their underlying 

condition can be treated. This work 

extends beyond traditional costing 

boundaries, Hodgson said. Linking the 

two systems together can ultimately save 

money for the healthcare system. “If we 

know that patients are on the diabetes 

register but are not managing their 

condition, what communication work 

can we do to get them to a clinic?” he 

said. “Do they know about clinics and 

support? We can target them and ensure 

that they get prevention support, because 

that is far cheaper than patching them up 

when they get into hospital. A lot more 

information is gained through 

combining the datasets — the sum of the 

two parts is far greater than the whole.”

Recent developments in healthcare 

solutions include government investment 

in “social prescribing”, which addresses 

issues such as loneliness, and by 

extension, better management of 

underlying health through therapeutic 

activities. But this growing focus on 

understanding patients at a granular level 

brings its own concerns for the �nance 

professional, Orme said. “It’s important to 

work very closely with information and 

governance leads to ensure that we 

comply with GDPR [the EU’s data 

protection laws], that everything we do is 

anonymised and is only available to the 

clinician responsible for that individual’s 

care,” he said.

Improving data quality is a key 

element of the costing role. Hodgson 

described the process for engaging 

clinical teams with the process. “We 

will publish data early, knowing that 

it’s not 100% correct,” he said. “But as 

soon as we put it out there and keep 

publishing it, people will start looking 

at it and start improving the quality of 

data. 

“In our early publishing of the red and 

green reason codes 80% of them were 

blank. But the fact that we were spending 

£20,000 a month on red days without 

knowing why soon raised awareness 

among clinicians. Realising that the 

codes would tell them where the money 

was going, clinicians now �ll in the 

codes and we have 90% completion.”

Skills and competences

Technology has freed up senior sta� time, 

allowing greater engagement with clinical 

colleagues. Hodgson explained that while 

junior sta� “turn the wheels”, getting data 

through the system and out, more 

experienced colleagues are using those 

same data for transformation. The 

o�ce-based bean-counter image is 

obsolete: Today’s cost accountant needs to 

have communication, presentation, and 

in�uencing skills, and be able to think 

outside the box. “Costing used to be a �rst 

job for people wanting to go on into 

business partnering,” Hodgson said. “But 

today a lot of our sta� come from 

�nancial management and management 

accounting roles, because they’re used to 

being part of a division in the hospital.” 

Technical skills are still crucial, Orme 

said. Cost accountants must maintain a 

separate cost ledger that cannot get out of 

balance with the general ledger, a practice 

that their last-century counterparts would 

certainly recognise. The ability to manage 

‘The whole point is to give the 
clinicians the information to 
make decisions. … We are here to 
guide them through the vast 
volumes of data.’
Scott Hodgson, ACMA, CGMA, head of costing for Nottingham University Hospitals

Nottingham University Hospitals’ costing team’s policy is to publish and debate 
results with clinicians, being mindful of the “Five Stages of Data Grief”. It has 
become adept at helping colleagues get across the stages very quickly and have 
found that peer-to-peer discussions can sometimes be key to removing 
barriers.

 1 Denial: “The data is wrong!”

 2 Anger: “It does not apply to me.”

 3 Bargaining: “I will get the correct data.”

 4 Depression: “There is nothing I can do about it.”

 5 Resolution: Acceptance and action.

5 stages of data grief

The
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Cost accounting took slow route to appreciation

A wartime yearning for efficiency and value evolved finance practices.

A
lthough it took centuries for business leaders to fully 
appreciate the utility of cost accounting, the practice 

— once embraced — established a value that remains 
essential to organisations throughout the world today.
 While the roots of modern cost accounting can be traced 
back to the 18th-century Industrial Revolution, progress 
towards professionalising the practice was slow. Cost 

Accounting Principles and Practice, a costing textbook 
published in 1920, a year after CIMA’s first incarnation as the 
Institute of Cost and Works Accountants, highlights the 
frustration of costing pioneers at the slow recognition of 
their value: 

Hardly any other feature of industrial procedure has been 
so necessary, yet so slow in developing, as cost 
accounting — so rich in possibilities of usefulness for 
management of business, yet so widely considered for 
many years as a doubtfully necessary evil.

By 1937, however, the Institute had published its first 
“Costing Terminology”, and cost accounting was well on its 
way to being established as a science. World War II saw 
increased demand for costing professionals in government 
and industry to help ensure efficiency and value for money. 
By the 1950s, costing played a key role in the ICWA 
qualification, in which seven of the 16 papers focused 
exclusively on costing (wages, materials, overheads, and 
methods). By 1975, the Institute of Cost and Management 
Accountants, as CIMA was then known, had been awarded a 
Royal Charter. The focus of the qualification began to shift 
towards strategic accounting, and in 1986 the ICMA became 
the Chartered Institute of Management Accountants.

An article by Roland Dunkerley, FCWA, in The Cost 

Accountant, the official journal of the Institute of Cost and 
Works Accountants and a precursor to Financial Management 

magazine, dated 1946, traces the early history of the costing 
profession. Driven by the changed industrial circumstances 

and economic conditions of World War I, costing practices 
evolved from the factory floor rather than the finance office, 
with a focus on efficiency. Dunkerley, who was the ICWA’s 
president in 1933–1934, wrote: 

It was necessary for [the cost accountant] to have 
considerable knowledge of the factory and its 
products, and to keep abreast of all the developments 
in management technique which were becoming 
more widely used: time and motion study, use of tools 
and jigs, causes of stoppages of machinery, layout of 
stores, questions of transport, and — by no means the 
least important — the devising of methods to give the 
maximum of information with the minimum of 
clerical work.

Rebecca McCaffry, FCMA, CGMA, 

is associate technical  

director–Management Accounting at 

the Association of International 

Certified Professional Accountants. To 

comment on this article or to suggest 

an idea for another article, contact 

Ken Tysiac, FM magazine’s editorial 

director, at Kenneth.Tysiac@ 

aicpa-cima.com.

huge volumes of data and pick out core 

messages is also essential to success (see 

the sidebar “The 5 Stages of Data Grief”). 

Hodgson agrees. “The whole point is to 

give the clinicians the information to 

make decisions, not for us to do it,” he 

said. “We are here to guide them through 

the vast volumes of data.”

Resilience is also a key skill for the 

costing practitioner. “We can’t tell our 

colleagues they are spending too much,” 

Hodgson said, “because we don’t know 

enough about clinical care. But we can 

present the information we have, and ask, 

‘Does this look right to you?’ Invariably 

they’ll say something doesn’t look right, 

and we work with them to improve it.”

The pace of transformation in 

healthcare is accelerating, Orme said, with 

clinicians ever more keen to understand 

costs, their practice, and their patients. As 

a result, cost accountants are once more at 

the forefront of health delivery. “If you 

have that enthusiasm, curiosity, and 

desire to understand, and wish to 

in�uence and help your clinical 

colleagues, then this is a cracking job for 

you,” Orme said.   Q
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‘It is obvious from its 
record that cost 

accountancy is a dynamic, 
and not a static, force. It is 

a profession  filled with 
possibilities and with  

great interests …’  
�e Cost Accountant, 1946



Ask the Expert • LEASES
ADVERTISING SUPPLEMENT

John Kuett 
Vice-President–European 
Lease Accounting 
LeaseAccelerator

John Kuett heads accounting 

strategy for LeaseAccelerator, 

the software-as-a-service (SaaS) 

solution for Enterprise Lease 

$FFRXQWLQJ��+H�KDV����\HDUV·�

H[SHULHQFH�GLUHFWLQJ�FRPSDQLHV·�

ÀQDQFLDO�UHSRUWLQJ�DQG�FRPSOLDQFH�

with IFRS 16 and ASC 842. He is an 

IFRS expert, specialising in topics 

such as IFRS 15, IAS 16, and  

IFRS 16 leases.    

LeaseAccelerator offers the market-

leading SaaS solution for Enterprise 

Lease Accounting, proven to be the 

simplest, fastest, and easiest path 

to compliance with the new IFRS 16 

standards. The company’s ecosystem 

of certified, global partners delivers a 

variety of guaranteed turnkey solutions. 

On average, the firm’s Sourcing and 

Management applications drive savings 

of 17% with smarter procurement  

and end-of-term management.  

Visit explore.leaseaccelerator.com. 

*DLQLQJ�HIÀFLHQF\�LQ�OHDVH�DFFRXQWLQJ

Q +RZ�GRHV�,)56����RIIHU�FRPSDQLHV�DQ�RSSRUWXQLW\�IRU�JUHDWHU�

HIÀFLHQF\"����

A Implemented by the International Accounting Standards Board, the new 

lease accounting standards are now taking effect. Companies are transferring 

an estimated $3 trillion of operating leases onto corporate balance sheets as 

right-of-use assets and corresponding lease liabilities. Historically, only a limited 

VHW�RI�RSHUDWLQJ�OHDVH�LQIRUPDWLRQ�KDV�EHHQ�UHSRUWHG�LQ�DQQXDO�ÀQDQFLDO�UHSRUW�

footnotes. Under the new IFRS 16 standards, companies must add new line 

items to the balance sheet for leases and develop strategies for communicating 

WKHVH�FKDQJHV�WR�WKHLU�LQYHVWRU�FRPPXQLWLHV��.H\�ÀQDQFLDO�PHWULFV��VXFK�DV�

return on assets, EBITDA, and the quick ratio will be impacted. 

Q :KDW�GR�WKHVH�FKDQJHV�PHDQ"�

A 7KHVH�QHZ�OHDVLQJ�VWDQGDUGV�ZLOO�EULQJ�JUHDWHU�FODULW\�WR�FRPSDQLHV·�DVVHW�

LQYHVWPHQW�VWUDWHJLHV�DQG�LPSDFW�ÀQDQFLDO�PHWULFV��&RPSDQLHV�ZLOO�QRZ�GHVFULEH�

WKHLU�DVVHW�LQYHVWPHQW�VWUDWHJLHV�LQ�WHUPV�RI�PD[LPLVLQJ�FDVK�ÁRZV�DQG�ÁH[LELOLW\�

pertaining to the duration of commitment to the use of the asset. Leasing 

activities are now subject to increased scrutiny by many companies by virtue of 

new corporate governance over the acquisition of leased assets. The adoption 

of the standard was challenged by compiling the contracts usually decentralised 

throughout a company, analysing terms and conditions of the contracts, and 

having an understanding of leasing activity by asset class. Now, as a result of 

the transparency of the new standard, the post-implementation challenges for 

companies are change management for procurement, IT, and operations, plus 

the new corporate governance over leasing activities. 

Q +RZ�FDQ�FRPSDQLHV�WDNH�DGYDQWDJH�RI�WKLV�RSSRUWXQLW\"������

A $OWKRXJK�WKH�LPSOHPHQWDWLRQ�RI�WKHVH�VWDQGDUGV�FUHDWHV�D�VLJQLÀFDQW�

DGPLQLVWUDWLYH�EXUGHQ�DW�PDQ\�ODUJH�ÀUPV��LW�DOVR�LQWURGXFHV�QHZ�RSSRUWXQLWLHV��

In addition to improving external transparency into corporate leasing obligations, 

the standards also increase internal transparency. This added transparency 

will allow proactive management accountants to assess the current processes 

their business has in place and focus the asset acquisition process into three 

GHFLVLRQV��ZKDW�DVVHW�LV�QHHGHG��GXUDWLRQ�RI�LQWHQGHG�XVH��DQG�ÁH[LELOLW\�WR�UHDFW�

to obsolescence concerns or changes in the business, plus key metrics such 

DV�(36�DQG�WDUJHW�IUHH�FDVK�ÁRZ��2WKHU�SURFHVV�LPSURYHPHQWV��IRU�H[DPSOH��

are the creation of standardised lease contracts to use in procurement efforts. A 

standardised contract may improve comparability among offers and competitive 

WHUPV��LQ�DGGLWLRQ�WR�FUHDWLQJ�DQ�RSHQ�FDSLWDO�PDUNHW�LQ�ZKLFK�WKH�ÀUP�FDQ�

leverage competition among asset vendors to receive the best offer. 

 The new accounting standards offer companies an opportunity to challenge 

existing processes and reinforce the economic analysis behind both lease and 

buy decisions. Companies should take advantage of this — designing and 

RXWVRXUFLQJ�SURFHVVHV�IRU�PDQDJLQJ�OHDVHV�DQG�LQFRUSRUDWLQJ�HIÀFLHQF\�E\�

design. 

John Kuett  

*DLQLQJ�HIÀFLHQF\�LQ�OHDVH�DFFRXQWLQJ

Q  +RZ�GRHV�,)56����RIIHU�FRPSDQLHV�DQ�RSSRUWXQLW\�IRU�JUHDWHU�

Q  :KDW�GR�WKHVH�FKDQJHV�PHDQ"�Q  :KDW�GR�WKHVH�FKDQJHV�PHDQ"�

Q  +RZ�FDQ�FRPSDQLHV�WDNH�DGYDQWDJH�RI�WKLV�RSSRUWXQLW\"������ Q  +RZ�FDQ�FRPSDQLHV�WDNH�DGYDQWDJH�RI�WKLV�RSSRUWXQLW\"������ 
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Former Unilever CEO Paul Polman 

took on short-termism, climate 

change, and income inequality 

at the CIMA President’s London 

Centenary Dinner. 

By Oliver Rowe

O
n 8 March 2019, 100 years to the day after CIMA was 

formed, Paul Polman, HonFCMA, delivered a speech 

to the almost 200 guests at the CIMA President’s 

Dinner in Merchant Taylors’ Hall in London. 

Polman is chair of the International Chamber of 

Commerce, chair of The B Team, and vice-chair of the UN Global 

Compact, a voluntary strategic initiative to encourage businesses 

to achieve the UN’s Sustainable Development Goals. For ten years 

until December last year he led Unilever with a personal mission 

to “galvanise our company to be an e�ective force for good”.

It was highly appropriate that he spoke at the dinner. CIMA’s 

�rst president in 1919 was Lord Leverhulme, who founded Lever 

Brothers — the company that went on to become Unilever in a 

merger with Dutch company Margarine Unie in 1929.

Polman’s speech started by acknowledging CIMA’s route from 

its beginnings in 1919 and ended with a standing ovation. In 

between, he recognised International Women’s Day (also 8 March) 

and covered issues pertinent to a better future for business and 

humanity — and challenged accountants to play a greater part in 

achieving that. Here are some key (edited) quotes from the speech.

A challenge to

the profession  
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On short-termism

“We’re running [companies] into the ground with short-termism 

— this myopic focus on shareholders. There’s no question about it, 

especially when you think that 50% or more of the investments 

companies make create value for a company only three to �ve 

years out or more. It’s bizarre that we have let this happen. 

“Christine Lagarde [IMF managing director and chair] 

summed it up very well when she said … the �nancial sector 

[prioritises] … pro�ts over long-range prudence and short term 

over sustainability. That’s what is happening.”

On GDP

“How we de�ne GDP, industrial output — pretty narrow 

measure. Should have never been used as a measure of the 

wellbeing of a country. We produce more weapons or wage wars, 

GDP goes up. We produce cleaner air or better education, we 

don’t see anything in GDP. A little bit bizarre to me.”

On wealth inequality

“The �nancial crisis showed one thing to people in the street, if 

you like it or not. It showed that banks were too big to fail and 

people were too small to matter. It’s as simple as that.

“Many people have not seen any progress in the last 30 to 40 

years. Last year alone the bottom 3.8 billion people in the world, 

the poorest people, saw their combined net worth go down by 

11% … whilst the billionaires saw their net worth go up by 900 

billion [dollars], 2.5 billion a day.”

 

On equal pay for women and men

“[Some people] say, ‘Yeah, we know we have a di�erence, but 

between now and 2020, we’ll �x it. Or 2025, so we’re on it, we’re 

on it.’ Well, if you have a problem now, why don’t you �x it now?”

On climate change

“We can actually [limit the temperature rise to] one and a half 

degrees in the next 30 or 40 years if we decide to do so. If we 

don’t decide to do so, we’re about to commit the biggest 

intergenerational crime in the history of humankind. Let me be 

clear on that.”

On development goals

“It costs far less than the 10–12% of GDP that we are now 

spending [wastefully] on con�ict, defence, and wars than in 

implementing the total Sustainable Development Goals with the 

simple objective to irreversibly eradicate poverty and do that in a 

more sustainable and equitable way, to leave no one behind, to 

�nish the job that Ko� Annan [former UN secretary-general] 

started in the �rst 15 years of his Millennium Development 

Goals.

“On each of these famous 17 [Sustainable Development] 

Goals, the cost of not acting is now higher than the cost of acting. 

And we call ourselves the most intelligent species.”

Challenge to accountants

“What world are we steering ourselves to with our systems that 

we’ve produced, including our accounting systems? … Are we 

creating wealth for a few, a few islands of prosperity in oceans of 

poverty? …

“Now, we know how to optimise �nancial factors, but we 

won’t solve the issues of climate. We won’t solve the future of 

humanity if we don’t broaden that and also … optimise our 

return on not only �nancial capital, but also social and 

environmental capital. What’s wrong with that?”   Q
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Paul Polman, HonFCMA, 
speaks at the Centenary Dinner.

Oliver Rowe is an FM magazine senior editor. To comment on 

this article or to suggest an idea for another article, contact 

him at Oliver.Rowe@aicpa-cima.com.
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Technologies such as Excel help 

accountants work smarter and faster, but 

even greater efficiency is available to those 

who learn to use tech tools more effectively. 

By Kelly L. Williams, CPA, Ph.D., and Byron Patrick, CPA/CITP, CGMA 

quick technology tips 
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A
ccountants are always looking for 

ways to do more and better work 

in less time. Technology tools are 

great aids in that quest, but they 

can do even more if you know 

the right techniques. To celebrate CIMA’s 

centenary, FM magazine is pleased to present 

100 tips and tricks for better leveraging 

technologies such as Microsoft Excel (some 

features are available only in the latest 

Microsoft O�ce and Windows versions). 
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Excel quick tips

1. Hide zero values. Including many zero values in your data 

can be distracting. To easily hide zero values, go to the File 

tab, Options, Advanced, and uncheck Show a zero in cells 

that have zero value.

2. Delete blank rows. You may have a spreadsheet with blank 

rows that are spread throughout the worksheet. Instead of 

deleting each blank row individually, you can delete all blank 

rows at once. For this to work, your header rows must be on 

the �rst row of the spreadsheet. Select the entire columns 

that contain your data by clicking on the letters at the very 

top of the columns. On the Data tab, Sort & Filter group, 

select Filter. Click the drop-down arrow on the right side of 

the �rst column of your data, uncheck (Select All), and 

check (Blanks). If any numbers are still visible, go to the 

second column of your data and repeat the step above. 

Continue to repeat the steps for each column until no data 

appear. Select the �ltered rows and go to the Home tab, Cells 

group, and select Delete. On the Data tab, Sort & Filter 

group, select Clear.

3. Name a cell or range of cells. A cell or a range of cells can be 

given a name in Excel. You can reference the name in your 

formulas and functions rather than trying to remember or 

�nd a speci�c cell or range of cells. To do this, highlight the 

cell or range of cells that should be named, then type the 

name in the Name Box (the box to the left of the formula 

bar). Click Enter.

4. Instantly select an entire table or data range. To instantly 

select an entire table or data range, click anywhere within the 

table or data range and press Ctrl+A.

5. AutoSum shortcut. To quickly sum a list of values, select 

the cell at the bottom of a vertical list of values or to the right 

of a horizontal list of values and press Alt+=, then Enter.

6. Quickly foot and crossfoot. AutoSum can be used to insert 

sum formulas that total all columns and rows at the same 

time. Highlight a table of data, plus one additional row below 

and one additional column to the right of the data. Click the 

AutoSum button or press Alt+=.

7. Transpose data. Sometimes you need data that are 

organised horizontally to be vertical, and vice versa. To do 

this, copy the data and place your cursor in the �rst cell you 

want the data to be pasted. On the Home tab of the ribbon, 

select Paste from the Clipboard group, then select Paste 

Special. Check Transpose, then click OK.

8. Sort data based on colour. Sorting data in Excel is not limited 

to sorting based on cell values. Data can also be sorted based 

on cell colour and font colour. To do this, select the data to be 

sorted. On the Home ribbon tab, select Sort & Filter from the 

Editing group, then select Custom Sort. Ensure that My data 

has headers is checked if headers were included in your 

selection. In the Sort by drop-down list, choose the column 

on which you want to sort. In the Sort On drop-down list, 

choose Cell Color or Font Color. In the Order drop-down list, 

choose the colour you want shown �rst. Next, click Add Level 

located at the top left of the Sort window. Complete the same 

steps as above for the second colour that should be shown, 

and so on until you have instructed Excel on the order in 

which to sort all cell colours or font colours.

9. Quickly resize a column to �t contents. You may have data 

in a cell that is much shorter than, or too long to �t in, the 

default width of a column. Instead of trying to manually 

adjust the width of the column to get the right size, double-

click the boundary between two column headers (eg, the line 

between the A and the B for the �rst and second columns), 

and the column size for the column to the left will be 

perfectly sized to accommodate the cell with the longest text.
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10. Extract characters from the left of a text string. You may 

need to extract a portion of data to the left of a text string. For 

example, you may need to extract the area code of a phone 

number. Use the function LEFT(Text, Num_chars). For 

Text, reference the cell that contains the text string. For 

Num_chars, enter the number of characters to the far left of 

the text string to extract. Click OK.

11. Extract characters from the right of a text string. You may 

need to extract a portion of data to the right of a text string. 

For example, you may need to extract the last four digits of a 

National Insurance number. Use the function RIGHT(Text, 
Num_chars). For Text, reference the cell that contains the 

text string. For Num_chars, enter the number of characters 

from the far right of the text string to extract. Click OK.

12. Extract characters in the middle of a text string. You may 

need to extract a portion of data in the middle of a text string. 

For example, you may need to extract digits in the middle of 

a product number. Choose the function MID(Text, [Start_
num], [Num_chars]). For Text, reference the cell that 

contains the text string. For Start_num, enter the position of 

the �rst character to extract (eg, if you wanted to start 

extracting at the fourth character in a text string, the 

Start_num would be 4). For Num_chars, enter the number 

of characters from the Start_num of the text string to 

extract. Click OK.

13. Merge multiple cells into one text string. You may need to 

combine data from various cells into one text string in one 

cell. You can also include spaces, symbols, etc, in the new 

text string you are creating. Choose the function 

CONCATENATE (Text1, Text 2, etc). For Text1, enter the cell 

reference, text, or any other characters for the beginning of 

the text string. For Text2, enter the cell reference, text, or 

other characters for the next part of the text string, and so on. 

For example, if you had a �rst name in cell A1 and a last name 

in cell B1, and you wanted to combine the �rst and last name 

into one cell with a space separating the two, you would 

reference cell A1 for Text1, enter a space (in quotes) for Text2, 

and reference cell B1 for Text3: CONCATENATE (A1," ",B1).
14. Hide/unhide worksheets. To hide a worksheet, right-click 

on the tab of the worksheet (located at the bottom of the 

Excel workbook) and select Hide. To unhide a worksheet, 

right-click on any tab of the worksheet, select Unhide, then 

choose which sheet to unhide.

15. Hide/unhide columns/rows. To hide columns or rows in a 

worksheet, select the columns or rows to be hidden, 

right-click within those rows or columns, and select Hide. To 

unhide columns or rows in a worksheet, select the columns 

or rows surrounding the hidden columns or rows, right-click 

within those columns or rows, and select Unhide.

16. Copy visible cells only. You may have a spreadsheet with 

hidden rows and/or columns but want to copy only the cells 

that are visible. To do this, click F5, Special, Visible cells 

only, OK. Then press Ctrl+C to copy.

17. Sum data from various places on a spreadsheet. You may 

need to sum values that are not all listed together in a 

spreadsheet. You can sum these values, but you cannot use 

the AutoSum shortcut or the AutoSum tool. Choose the 

function SUM. For Number1, select a cell or range of cells 

that will be included as part of the total. For Number2, select 

another cell or range of cells that will be included as part of 

the total. Continue for Number3, if needed, and so on until 

you capture all numbers that should make up the sum. Click 

OK. Example: SUM(A2,C9:C12,E5). 
18. Instantly copy a formula to multiple rows. Many of the 

formulas we use are intended to work for multiple rows of 

data. In that case, when a formula is added to your �rst row 

of data, that formula needs to be copied down to all rows of 

data. Instead of grabbing the Fill Handle (the solid green box 

that appears in the bottom right corner of a cell when it is 

selected) and dragging all the way down, it is easier and 

quicker to simply double-click the Fill Handle. This will 

work if the cells in the column to the left of the copied 

formulas are not empty. 

19. Freeze panes. When you have a large spreadsheet with titles 

for the columns and rows, it becomes di�cult to know 

which cell you are viewing if you have scrolled where you 

can no longer see the column and/or row titles. To keep the 

column and row titles on the screen, select the cell below the 

�rst column title and to the right of the �rst row title. On the 

View tab, select Freeze Panes from the Window group, then 

select Freeze Panes.

20. Visually represent your data using Sparklines. Sparklines 

are small charts that �t in a single cell and are used to 

visually represent your data (see cells G3:G5 in the screenshot 

“Sparklines Examples”). Select the cell or cells where you 

would like the Sparkline(s). On the Insert tab, within the 

Sparklines group, choose Line, Column, or Win/Loss. 

Select the data to be included in the Sparkline(s). 

21. Instantly convert a range of data into a table. To convert a 

range of data into a table, click anywhere within the range of 

data and press Ctrl+T.

22. Convert a table into a range of data. To convert a table into 

a range of data, click anywhere within the table and right-

click. Select Table, then Convert to Range.

23. Instantly chart a range of data. To chart a range of data, 

click anywhere within the range of data and press Alt+F1.

24. Switch between formulas and values. You can easily view 

your formulas by pressing Ctrl+` (grave accent). This will 

allow you to view all formulas. Clicking it again will switch 

you back to viewing values. 
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25. Change the case of text to all uppercase. To change text to 

all uppercase, click the cell where you would like the 

uppercase text to appear. Choose the function UPPER(Text). 
For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

26. Change the case of text to all lowercase. To change text to 

all lowercase, click the cell where you would like the 

lowercase text to appear. Choose the function LOWER(Text). 
For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

27. Change the case of text to capitalise the �rst letter of 

each word and all other letters to lowercase. To change 

the text to capitalise the �rst letter of each word and make all 

other letters lowercase, click the cell where you would like 

the converted text to appear. Choose the function PROPER. 

For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

28. Disable AutoCorrect one time for one situation. 

AutoCorrect can be very useful for �xing unintentional 

grammatical errors. However, sometimes Excel will continue 

“correcting” something that is not an error and should not be 

changed. You can instruct Excel to stop “correcting” this 

temporarily by typing the word, hitting the spacebar once, 

then clicking Undo or pressing Ctrl+Z.

29. Disable AutoCorrect permanently for one situation. You 

can instruct Excel to stop “autocorrecting” a word 

permanently by going to File, Options, Proo�ng. Select 

AutoCorrect Options and scroll down to �nd the word that 

Excel is autocorrecting. Click on the word and choose Delete. 

Click OK.

30. Create a Text Box. To create a text box, go to the Insert tab, 

Text group, and select Text Box. Left-click on the mouse and 

drag to create the borders of the text box. You can then type 

text inside the text box.

31. Convert formulas to values. To convert formulas to values, 

select all formulas or the entire worksheet or workbook and 

press Ctrl+C to copy. On the Home tab, Clipboard group, 

select Paste, then select Paste Special. Select Values, then 

click OK. Or, after copying, press Shift+F10+V.

32. Insert a line break within a cell. You may need to have 

multiple lines within a cell. For example, a heading for an 

income statement should include the company name, below 

that, the text “Income Statement”, and below that, the ending 

period. To have all three rows within one cell, you must 

insert a line break after each line of data by pressing 

Alt+Enter.

33. Find and replace. Find and replace has many useful abilities, 

such as �nding a misspelled word and replacing it throughout 

an entire worksheet; using a shortened word while creating a 

spreadsheet and replacing it with the long version when you 

are done; reusing a worksheet for a new client and instantly 

replacing the name; etc. Press Ctrl+H. Enter what you want to 

�nd in Excel next to Find what: (eg, old client name), then 

enter what you want the found data to be replaced with next to 

Replace with: (eg, new client name).

34. Display Excel with no gridlines. You can remove the 

gridlines from your Excel worksheet by going to the View 

tab, Show group, and unchecking Gridlines.

35. Add �lters to your data. To add �lters to your data, select 

the data to be �ltered. On the Home tab, Editing group, 

select Sort & Filter, then Filter.

36. Quickly switch between di�erent Excel �les. To quickly 

switch between di�erent Excel �les, press Ctrl+Tab.

37. Customise Quick Access Toolbar. The Quick Access Toolbar 

is at the very top left side of Excel (unless you have moved it). 

By default, the Quick Access Toolbar includes an icon to 

Save, Undo, and Redo. Click the drop-down arrow to the far 

right of the Redo icon, and you can customise this Quick 

Access Toolbar by adding or removing icons.

38. Customise status bar. The status bar is at the very bottom of 

Excel. By default, the status bar includes many status 

settings, including showing the Average, Count, and Sum of 

the data selected. These statistics can be very useful. If you 

right-click on the status bar, you can customise it to show 

more or fewer statistics and adjust other status features.

39. Preserve leading zeros. If you enter a number in Excel that 

begins with one or more zeros, Excel will delete the leading 

zeros. To keep the leading zeros, add a single quote in front 

of the �rst zero, and Excel will preserve the leading zeros, 

though it will treat the entry as text rather than a number.

40. Recover an unsaved workbook. Excel will autosave your 

Excel workbooks (by default, every ten minutes). If you have 

not previously saved your workbook and then close the 

workbook by mistake or if your computer closes without the 

workbook being saved, you can recover the document. Go to 

File, Open, Recent Workbooks, Recover Unsaved 

Workbooks, and choose the �le that was closed before it was 

saved.

41. Instantly create a PivotTable without learning about 

PivotTables. PivotTables are extremely useful tools, but if 

you have not yet had the chance to learn how to create one, 

Excel may be able to do all the work for you. Select the data to 

be included in the PivotTable, go to the Insert tab, Tables 

group, and select Recommended PivotTables. If there are 

enough data, Excel will give you some options of PivotTables 

to choose from.

42. Import a table from the web into Excel. You can import a 

table from the web into an Excel workbook. Go to the Data 

tab, Get & Transform Data group, and select From Web. 

Enter the URL of the webpage containing the table when 

prompted and click OK. Choose the desired table from the 

Navigator window and click Load.

You can repeat the last
action you did in Excel
by pressing Ctrl+Y.
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43. New workbook shortcut. To open a new workbook, press 

Ctrl+N.

44. New worksheet shortcut. To create a new worksheet, press 

Shift+F11.

45. Select all cells in a spreadsheet. To select all cells in an 

Excel worksheet, click the triangle to the top left of the 

spreadsheet located between column A and row 1.

46. Ensure your Excel workbook is accessible to people with 

certain disabilities. Various disabilities can cause a person 

to have di�culty comprehending certain content. Making 

content accessible is about improving characteristics of 

content that could otherwise limit a person’s 

comprehension. Excel can check your Excel workbook for 

accessibility. Go to File, Info, Check for Issues, Check 

Accessibility. Excel will then provide the results, which can 

include errors, warnings, and/or tips, or con�rmation that 

your content is accessible.

47. Repeat the last action. You can repeat the last action you 

did in Excel by pressing Ctrl+Y. This is a much more e�cient 

way of doing something in Excel that needs to be done 

repeatedly. 

48. Perform the same action to a group of consecutive 

worksheets simultaneously. If you need to perform the 

same action to multiple worksheets in your Excel workbook, 

you can group worksheets and perform that action only 

once. Left-click on the tab of the �rst worksheet to include, 

hold down the Shift key, and left-click on the last worksheet 

to include. You have now made those worksheets a group. Go 

to any of the worksheets and perform the desired action. You 

will see that action has been performed on all worksheets 

that were included in the group. When you are done, 

right-click on any of the worksheets in the group and select 

Ungroup Sheets.

49. Perform the same action to a group of nonconsecutive 

worksheets simultaneously. If you follow the instructions 

in the previous tip but use the Ctrl key instead of the Shift 

key, you can group individual worksheets that aren’t next to 

one another. 

50. Analyse components of a formula. Sometimes you need to 

analyse your formulas, possibly because you are getting an 

error message. One way to do this is by using a feature in 

Excel that shows you all the cells that are being used in the 

calculation of the formula. Click on the cell that contains the 

formula you want to analyse. Go to the Formulas tab, 

Formula Auditing group, and select Trace Precedents. This 

will display a blue arrow from all cells that are included in 

the formula.

51. Produce random numbers. To produce a list of random 

numbers, click in the cell that will contain your �rst random 

number. Use the function RANDBETWEEN. For the 

Bottom, enter the lowest number in the range of random 

numbers (eg, if you wanted numbers between 1 and 100, 1 

would be the Bottom). For Top, enter the highest number in 

the range of numbers (100 for the previous example). Drag 

that formula down (or across) as many times as needed to get 

the number of random numbers needed.

52. Remove duplicates. A dataset can have duplicate entries, 

such as a customer accidentally listed twice in a CRM 

database. To eliminate duplicate information, select the data 

you want checked for duplicates and go to the Data tab, Data 

Tools group, and select Remove Duplicates. Select all the 

columns you want Excel to check for duplicates (be careful 

only selecting something like last name when you could 

have multiple customers with the same last name). Click OK.

53. Quickly insert today’s date. To insert today’s date in your 

Excel worksheet, press Ctrl+; (semicolon). 

54. Quickly insert current time. To insert the current time in 

your Excel worksheet, press Ctrl+Shift+; (semicolon).

55. Format as numbers to include two decimal places, 

thousands separator, and a minus sign for negative 

values. To format as numbers to include two decimal places, 

a thousands separator, and a minus sign for negative values, 

press Ctrl+Shift+! (exclamation point).

56. Format as currency with two decimal places and 

negative numbers in parentheses. To format as currency 

with two decimal places and negative numbers in 

parentheses, press Ctrl+Shift+$ (dollar sign).

57. Format as percentage with no decimal places. To format 

as percentage with no decimal places, press Ctrl+Shift+% 

(percentage sign).

58. Strikethrough text. You may want to retain certain text but 

show a strikethrough on it. To do this, click the cell where 

you would like to include a strikethrough and go to the 

Home tab. Expand the Font group by clicking the arrow in 

the bottom right corner of that group, and put a check next to 

Strikethrough. Click OK.

59. Count the number of occurrences. You may need to count 

Flash Fill example (tip 60)
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the number of occurrences for certain things, such as the 

number of items in a list or the number of commissions 

earned by a salesperson, etc. Choose the function 

COUNT(Value1,[Value2] …). For Value1, select the cells that 

contain those occurrences. If there are other data to include 

in the count, include those for Value2 and so on. 

60. Quickly �ll cells with Flash Fill. Excel can automatically �ll 

in a column or row of data if it senses a pattern. For example, 

if your spreadsheet contains �rst and last names in column 

A, and you would like just the last names listed in column B, 

start typing the last names in column B and, once Excel 

senses the pattern, you will see all last names appear in 

column B, as shown in the screenshot “Flash Fill Example” 

on the previous page. Press Enter to keep Excel’s suggestions.

61. Visually represent your data using Data Bars. You can add 

Data Bars to cells to visually represent your data, as shown in 

the screenshot “Data Bars Example”. This can be helpful for 

interpreting and analysing data. Select the cells that you 

would like to contain Data Bars. On the Home tab, Styles 

group, select Conditional Formatting, then select Data 

Bars. Choose the colour of the Data Bars.

62. Round values up. Excel follows conventional rounding 

rules, but sometimes you may need to round up all numbers. 

Choose the function ROUNDUP(number, num_digits). For 

number, select the cell that contains the number to be 

rounded up. For num_digits, choose the number of decimal 

places to round. Then copy the formula down for all 

numbers.

63. Save Excel as PDF. To save a portion or all of your Excel 

workbook as a PDF, go to the File tab, Save As, Browse. 

Choose the desired location and type the desired name next 

to File name:. Next to Save as type:, choose PDF. Now, 

choose Standard (publishing online and printing) or 

Minimum size (publishing online). Click Options. Here, 

you can choose to include only a selection of a worksheet, an 

entire worksheet, or the entire workbook; document 

properties; etc. Click OK.

64. Embed Word, PDF, video, sound, or PowerPoint in Excel. 

To embed a Word document, PDF, video, sound, or 

PowerPoint slide(s), click in the Excel workbook where the 

object should be placed. On the Insert tab, Text group, select 

Object. To create a new object, select the object type on the 

Create New tab. To insert an object that has already been 

created, go to the Create from File tab and select Browse. 

Locate the object and double-click to select. You can check 

the Link to �le box if you want the embedded object to stay 

linked to the source �le and therefore be updated for any 

changes to the source �le. You can also check the Display as 

icon box, which will display the embedded object as an icon 

instead of the object itself. Click OK.

65. Increase numbers by a percentage. Excel can be used to 

increase numbers by a certain percentage. First, insert the 

amount of the percentage as a decimal added to 1. For 

example, a percentage increase of 20% would be entered as 

1.2 in a blank cell. Copy that number. Next, select the range of 

cells that should be increased by the percentage. On the 

Home tab, Clipboard group, select Paste, then select Paste 

Special. Select Multiply, then click OK. Your numbers will 

be changed to re�ect the percentage increase. See the 

screenshots “Percentage Increase Example” on the following 

page for an illustration. In this example, there is a list of 

products with their current prices. In order to change the 

prices to re�ect a 20% increase, 1.2 was entered in a blank cell 

(D1). That cell was copied, and the current prices were 

Data Bars example (tip 61)
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selected (B2:B10). Under Paste Special, Multiply was 

selected, and the prices for each product changed to re�ect a 

20% increase.

66. Use the “Tell me what you want to do” feature. There is a 

Tell me box located on the right of the last command on the 

ribbon in Excel. You can use this box to enter an action you 

want Excel to perform, such as freeze panes, print, or insert 

picture, or to get help on a particular subject. If possible, 

Excel allows you to immediately perform the action. The Tell 

me box will also allow you to get additional help on the 

subject you have entered through the Excel help content, or 

to use Smart Lookup, which browses the internet for help on 

the subject (see the screenshots “Tell Me Box Examples” on 

the following page). 

67. Insert hyperlinks. To insert a hyperlink in your Excel 

workbook, highlight the text, image, etc, that will be linked. 

Right-click and select Link. You can choose to link to an 

Existing File or Web Page and choose the path of the 

existing �le or enter the URL of the webpage. You can choose 

to link to a Place in This Document and choose the 

worksheet and cell reference/de�ned name. You can also 

choose a link to Create New Document or E-mail Address.

Beyond Excel tips

68. To quickly look at two windows side by side on a 

Windows computer, select a window, and press the 

Windows Key+left arrow key to “snap” it to the left side of 

your screen. You can snap a di�erent window to the other 

half of the screen by selecting the window and pressing the 

Windows Key+the right arrow. 

69. Set up Google Alerts for clients, customer, bosses, leads, 

family, etc. Visit google.com/alerts and set up your search 

criteria. Try to be as speci�c as possible to avoid false positives. 

There will be a preview of your search, as shown in the 

screenshot “Google Alerts Search Box” on the following page.

70. Use a password manager, which provides better security 

than trying to remember a bunch of di�erent passwords and 

also is incredibly convenient!

71. Turn o� all unnecessary noti�cations on your phone. 

The unnecessary interruptions to your day impact 

productivity signi�cantly. Don’t approach this all at once: As 

you receive noti�cations, decide if the noti�cation is 

mission-critical or can be silenced. 

72. When searching Google, hold down the Ctrl key when 

clicking links to open each link in a new tab. This way you 

never lose track of the search results page.

73. Use search whenever possible on your PC, on your phone, 

and in your email. On a Windows 10 PC, you can just begin 

typing after clicking the Start button. 

74. Windows Quick Assist, which is built into Windows 10, is 

an extremely easy method to share your screen without the 

need to download and install anything. To access easily, 

search (with tip 73) for “Quick Assist”.

75. Right-click on apps pinned to the taskbar to bring up lots 

of hidden options for various applications.

Percentage increase example (tip 65)
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Tell me box examples (tip 66)

76. Use the Save as PDF option built into Microsoft O�ce. No 

need to print and scan or use a third-party app.

77. Realise the power of touch. Microsoft O�ce ribbons are 

optimised for touchscreen. If using O�ce on a device with a 

touchscreen, press various menus with your �nger and see 

the di�erence. 

78. Stop typing the same email. Use Quick Parts in Outlook to 

quickly insert text you type out all the time. 

79. Change the time zone. When setting a diary appointment 

with someone in another time zone, change the 

appointment to invitee time zone to avoid mistakes. For 

example, if you are in Eastern time in the US and the other 

person agrees to meet at 1pm in London, simply change the 

appointment to London time and set it for 1pm.

80. Embed your videos into presentations. Stop linking to 

videos that won’t play o�ine. Move the presentation to 

another computer to test. Disconnecting from the internet 

isn’t a good enough test. When inserting your video, do not 

click Link to File. Instead, always choose Insert, as shown 

in the screenshot “Insert Video Example”. 

 

Google Alerts search box (tip 69) Insert video example (tip 80)
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81. Disable background data on your phone. It doesn’t just 

save data usage, it saves a lot of battery. For iPhone the 

feature is called Background App Refresh. Go to Settings> 

tap on General>scroll down and tap on Background App 

Refresh>toggle Background App Refresh o�. On Android 

the feature is called “Data Saver”. Go to Settings> 

Connections>Data Usage>Data Saver>toggle O�.

82. Use the Steps Recorder in Windows to record instructional 

steps to share with someone quickly.

83. Check the lighting. When on a video meeting, make sure 

you have adequate front lighting. For a quick and easy 

solution, try a USB LED light strip for under $10. By sticking  

it to your monitor, it will provide just enough front-facing 

light to provide good video quality. See an example at  

amzn.to/2F4kZ0c.

84. Use the mute button when not speaking on conference 

calls/video meetings. You can’t hear your own background 

noise, but everyone else can.

85. Use the built-in PowerPoint laser pointer when 

presenting your screen in a remote meeting. The virtual laser 

pointer is available either at the bottom right of a 

presentation screen or from the Presenter View.

86. Link your phone to your Windows 10 PC. Use the 

Microsoft phone companion app to send and receive text 

messages on your PC. From Windows 10 search for “Your 

Phone” and the app will walk you through the con�guration.

87. Integrate Cortana with your email, and Cortana will send 

you daily “Heads-up” reminders to follow up on things you 

said you would do in your email. For example, if you write in 

an email, “Je�, I will send you the schedule tomorrow”, 

Cortana will send you a reminder to send Je� the schedule. 

On your PC, search for “Cortana” and open the Search and 

Settings, and under the Permissions section click Manage 

the Information Cortana can access from other services. 

You will be able to select your email source and con�gure 

access. This will enable the Cortana reminder emails.

88. Always use multifactor authentication when it’s available 

in the application you want to use.

89. Use Bit.ly to shorten long URLs. As a bonus, you can track 

how many people click the links.

90. Open PDFs in Microsoft Word to quickly convert a PDF to an 

editable document. Open Word and from the Open menu 

select the PDF you would like to convert.

91. Use the “Delay” option in the Snipping Tool to capture 

menus that don’t stay open when you click New. One of the 

authors used a two-second delay to capture the snip titled 

“Snipping Tool Delay Option”.

92. Enable Clipboard history and use Windows Key+V to access 

multiple items on your clipboard. To enable it, search 

“Clipboard” on your PC and select Clipboard Settings.

93. Use the Morph transition in PowerPoint to easily animate 

objects. Morph is available in the Transition tab. To use it, 

duplicate a slide you have already created, move/resize 

objects on the second slide, and apply the Morph transition 

to both slides. 

94. Save your favourite animation. If you have a favourite 

Snipping Tool Delay option (tip 91) 
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Dynamic lock dialog box (tip 98) 

Insert screenshots example (tip 99) 

animation you want to use throughout your presentation, 

you can easily apply the same PowerPoint animations on 

every slide by adding the animation to the Master Slide. From 

the View ribbon select Slide Master and apply your edits.

95. Insert signature lines in Word. If you need to add a line 

where someone can sign in a Word document, choose the 

Signature Line option in the Text group on the Insert tab. 

96. Go back in time. Looking for something you were working 

on “the other day”? Press Windows Key+Tab to open a 

timeline of your activities in Windows.

97. Protect your computer from attack. Use Controlled Folder 

Access in Windows to protect your computer from potential 

ransomware attacks. 

98. Lock your computer when you are away. Use Dynamic 

lock to automatically lock your computer when you walk 

away from it with your phone. Search for it on your PC and 

click on the checkbox as shown in the screenshot “Dynamic 

Lock Dialog Box”.

99. Quickly insert screenshots into MS O�ce documents 

using the Insert>Screenshot option as shown in the 

screenshot “Insert Screenshots Example”. This feature will 

o�er you all of the windows that are already open without 

having to snip them.

100. Keep tabs on your apps. When using Alt+Tab to move 

between apps, you can use your mouse (or touchscreen) to 

quickly select the app you want to switch to.   Q

Use the Steps Recorder
to share instructional
steps with someone
quickly.
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OHYHO�DQG�DW�D�PXFK�ORZHU�FRVW�WKDQ�LI�\RX�GLG�LW�\RXUVHOI���

Q :K\�LV�WKH�FORXG�DUFKLWHFWXUH�VR�SRSXODU�IRU�ÀQDQFLDO�DQG�DFFRXQWLQJ�

V\VWHPV"����� 

A %XLOW�IRU�WKH�LQWHUQHW��FORXG�EDVHG�ÀQDQFLDO�DSSOLFDWLRQV�KDYH�WKH�DUFKLWHFWXUH�

WKDW�NHHSV�XS�ZLWK�WRGD\·V�VSHHG�RI�EXVLQHVV��7UXH�FORXG�DSSOLFDWLRQV�RIIHU�

GLUHFW��DOZD\V�RQ�DFFHVV�RQ�D�SHU�XVHU�SHU�PRQWK�VXEVFULSWLRQ��7KH\�DUH�

PXOWL�WHQDQW��ZKLFK�PHDQV�RQO\�\RX�FDQ�ORRN�DW�\RXU�RZQ�GDWD�³�HYHQ�WKRXJK�

\RX�VKDUH�D�VLQJOH�VHW�RI�UHVRXUFHV��DSSOLFDWLRQ�LQIUDVWUXFWXUH��DQG�GDWDEDVHV��

7KHUH�DUH�QR�FDSLWDO�LQYHVWPHQWV�RU�ORQJ�WHUP�FRPPLWPHQWV�EHFDXVH�\RX�GR�

QRW�EX\��OLFHQVH��RU�PDQDJH�WKH�XQGHUO\LQJ�KDUGZDUH��VRIWZDUH��RU�QHWZRUNLQJ�

LQIUDVWUXFWXUH��<RX�JHW�XSJUDGHV�DW�QR�DGGLWLRQDO�FRVW��

Q :KDW�GRHV�D�FORXG�EDVHG�ÀQDQFLDO�PDQDJHPHQW�V\VWHP�RIIHU�WR�WKH�

ÀQDQFH�WHDP"������ 

A $�EHVW�LQ�FODVV�FORXG�ÀQDQFLDO�PDQDJHPHQW�VROXWLRQ�LV�GHVLJQHG�WR�VFDOH�

ZLWK�\RXU�JURZLQJ�EXVLQHVV�ZLWKRXW�DGGLQJ�FRPSOH[LW\��,QVWHDG�RI�FUHDWLQJ�PRUH�

ZRUN��WKH�V\VWHP�FDQ�DXWRPDWH�\RXU�NH\�ÀQDQFLDO�SURFHVVHV��UHGXFH�UHOLDQFH�

RQ�VSUHDGVKHHWV��DQG�JLYH�XVHUV�JUHDWHU�YLVLELOLW\�LQWR�UHDO�WLPH�EXVLQHVV�

SHUIRUPDQFH��)LQDQFH�WHDPV�FDQ�DOVR�WDLORU�WKH�V\VWHP�WR�WKHLU�H[DFW�EXVLQHVV�

QHHGV�E\�FRQÀJXULQJ�ZRUNÁRZV��GDWD�HQWU\�VFUHHQV��DQG�SUHIHUHQFHV�³�DOO�

ZLWKRXW�FRVWO\�FRGLQJ�RU�,7�KHOS��

Q :KDW�VKRXOG�EX\HUV�ORRN�IRU�IURP�D�FORXG�ÀQDQFLDO�V\VWHP"

A )DVW�JURZLQJ�FRPSDQLHV�ZDQW�DQG�QHHG�D�PRGHUQ��,32�UHDG\�ÀQDQFLDO�

PDQDJHPHQW�V\VWHP��6WDUW�ZLWK�RQH�WKDW�RIIHUV�VROLG�DFFRXQWLQJ�DQG�UHSRUWLQJ�

IXQFWLRQDOLW\��SOXV�VWURQJ�FRQWUROV�WR�HQVXUH�FRPSOLDQFH�DQG�DXGLWDELOLW\��(QVXUH�

WKH�V\VWHP�RIIHUV�WKH�ÁH[LELOLW\�WR�VXSSRUW�\RXU�ÀUP·V�HYROXWLRQ�DQG�WKH�VFDODELOLW\�

WR�VXSSRUW�JURZWK�DQG�DXWRPDWLRQ�WR�NHHS�\RXU�ZRUNIRUFH�OHDQ��%H�VXUH�WKH�

V\VWHP�RIIHUV�UHDO�WLPH�YLVLELOLW\�DQG�LQVLJKW�LQWR�ERWK�RSHUDWLRQDO�DQG�ÀQDQFLDO�

PHWULFV�WR�KHOS�\RX�PDNH�WKH�ULJKW�GHFLVLRQV�DW�WKH�ULJKW�WLPHV��

Marc Linden 

&ORXG�EDVHG�ÀQDQFLDOV

Q  :K\�LV�LW�VR�KDUG�WR�JHW�JRRG�ÀQDQFLDO�LQIRUPDWLRQ"����

Q  ,V�WKH�FORXG�ULJKW�IRU�ÀQDQFH"�Q  ,V�WKH�FORXG�ULJKW�IRU�ÀQDQFH"�

Q  :K\�LV�WKH�FORXG�DUFKLWHFWXUH�VR�SRSXODU�IRU�ÀQDQFLDO�DQG�DFFRXQWLQJ�Q  :K\�LV�WKH�FORXG�DUFKLWHFWXUH�VR�SRSXODU�IRU�ÀQDQFLDO�DQG�DFFRXQWLQJ�

Q  :KDW�GRHV�D�FORXG�EDVHG�ÀQDQFLDO�PDQDJHPHQW�V\VWHP�RIIHU�WR�WKH�Q  :KDW�GRHV�D�FORXG�EDVHG�ÀQDQFLDO�PDQDJHPHQW�V\VWHP�RIIHU�WR�WKH�

Q  :KDW�VKRXOG�EX\HUV�ORRN�IRU�IURP�D�FORXG�ÀQDQFLDO�V\VWHP"Q  :KDW�VKRXOG�EX\HUV�ORRN�IRU�IURP�D�FORXG�ÀQDQFLDO�V\VWHP"
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W
hen the giant German 

conglomerate 

thyssenkrupp needed a 

new tower to test its 

lifts technology, the 

company originally planned to go the 

simple route, with an industrial, 

utilitarian design. It made �nancial sense: 

After all, the buildings used to test lifts’ 

capabilities are purely functional 

structures that are rarely viewed by the 

public. There’s no reason to invest in their 

appearance.

But then the company’s leaders had a 

change of heart. The new tower would be 

located close to a historic German town, 

and the leaders didn’t want to erect an 

eyesore that would mar the landscape. 

“We talked about it and thought, ‘Why 

don’t we do it as impressive architecture?’” 

remembered Katrin Hünger, CFO, 

Innovation Center of thyssenkrupp 

Elevator AG. It was a hard decision and a 

new one for the division, she said, but 

ultimately the senior sta� were all open to 

trying something di�erent. 

That was around 2012. Five years later, 

in the historic town of Rottweil, Germany, 

thyssenkrupp held an opening ceremony 

for its new, striking 246-metre-high tower 

with an unusual helical design. That’s 

when the senior sta� had a realisation, 

recalled Hünger: “We noticed that the 

Architecture 

that builds 
value 
Done well, it can pay off with more 

than just customers.

By Amanda Abrams

that builds 
value value 
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tower had the potential to become an 

icon, a symbol for thyssenkrupp with a 

certain marketing bene�t.”

That observation was an 

understatement. Since its opening in 2017, 

the tower has received enormous media 

attention, attracted hundreds of 

thousands of visitors, and potentially 

shifted public perceptions of 

thyssenkrupp itself. In short, the tower’s 

distinctive architecture now serves as a 

strategic and highly public calling card, 

allowing thyssenkrupp to rebrand itself 

and illustrate, in the most tangible way, 

the strengths and values it wants to 

promote.

Obviously, not every company has, or 

needs, a soaring tower to show o� to the 

world. But for those considering an 

upgrade to their physical facilities, 

architecture can be a remarkably strategic 

decision. Experts and businesses that 

have gone that route say a building’s 

unique design can help a company stand 

out to clients, appeal to customers, and 

— particularly important at a time when 

talented workers are a precious resource 

— attract potential employees.

Thyssenkrupp’s 246-metre-tall tower 
dominates the skyline above Rottweil, Germany.
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A soaring helical tower

A blue-chip manufacturing company with 

a February market cap of €9.8 billion ($11 

billion) that started out as a steelmaker in 

the 1800s, the company is undergoing a 

major restructuring with a planned split 

between the industrial and materials 

groups. Thyssenkrupp had already begun 

strategically thinking about how 

architecture informed its reputation in 

the early 2000s, when it contemplated 

building a new headquarters. Generally 

perceived as solid, reliable, and perhaps a 

bit staid, the company was looking to 

create a new image for itself. 

In the end, the business invested in an 

environmentally sustainable, 

architecturally distinct low-rise campus 

in Essen, Germany, that opened in 2010. 

The hope was that the modern 

headquarters would help shape a new 

public perception of thyssenkrupp as an 

innovative, dynamic, and technologically 

savvy business. 

So the construction of thyssenkrupp’s 

test tower had a precedent, although 

leaders in the lift division say their 

decision was made independently. While 

architecture. In response, the lift 

division’s leadership decided to create 

something di�erent, “something very 

special that is capable of gaining attention 

internationally,” Hünger said. 

Thyssenkrupp’s leaders had a hunch it 

could also pay o� by shifting the 

business’s image. With an innovative 

tower, “we can show we’re a tech-driven 

company”, Hünger said.

After soliciting bids from architects, 

the company chose Werner Sobek and 

Helmut Jahn, who produced a design for a 

246-metre tower clad in a unique 

glass-�bre “skin” and with an observation 

deck at the top. In December 2014, 

thyssenkrupp held a ground-breaking 

ceremony. 

“Of course, it’s not always easy to talk 

with [architects] — you have to �nd a way 

to have imagination, but it has to also be 

very industrial,” Hünger said. Once 

construction began, the company’s 

project managers had to stay on top of the 

building’s progress, which required 

intense coordination; at the peak of its 

construction progress, the tower grew by 

four metres a day. “The construction of 

not particularly well known, the 

company’s lift division is large — it earned 

€866 million ($980 million) before 

interest and taxes in 2017–2018 — and 

remarkably high-tech. The division builds 

the ropeless MULTI lift that can move 

sideways and diagonally, as well as up and 

down. But those newer forms need towers 

where they can be tested at high speeds. 

Formerly, all of thyssenkrupp’s test 

towers were indistinct and somewhat 

hidden away. “Our industry used to build 

elevator test towers in industrial zoning 

areas where hardly anybody would notice 

them,” said Hünger. 

But the company’s leaders felt that the 

tower planned near Rottweil — which is 

the oldest town in that part of southern 

Germany — should somehow 

complement the area’s historic 

Visitors look out over 
the countryside from the 
thyssenkrupp tower’s 
observation deck.
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the tower was a challenge for everybody 

involved. We hadn’t done anything like 

this before.”

But the project �nished largely on 

time, at a total cost of €40 million ($45.2 

million). Hünger, who is in charge of the 

lift division’s �nances, estimates that the 

tower’s spectacular architecture added 

10% to 15% to the total cost.

It’s an investment that has paid o� in 

multiple ways since the tower opened in 

October 2017. First, there’s an overtly 

�nancial aspect that took Hünger and her 

colleagues by surprise. “The tower has 

become a tourist attraction. Visitors come 

from all over the world,” she said. 

Thyssenkrupp had originally estimated 

attracting 100,000–150,000 visitors during 

the tower’s �rst couple of years. In fact, in 

the �rst 12 months after it opened, 

230,000 people paid the €9 entrance fee to 

ascend to the viewing platform and look 

out over the countryside.

It has also paid o� in media coverage. 

According to Jasmin Fischer, head of 

media relations for the lift division, 

almost 2,000 stories about the building 

appeared in print and online publications 

in 91 countries in the �rst year after the 

opening. The articles mention the unique 

tower, of course, but many also describe 

the company’s innovative lifts. Media 

attention has been so strong that 

thyssenkrupp didn’t have to spend a 

single euro advertising the tower or the 

lift division’s products in the �rst 12 

months after the tower opened, Fischer 

said. 

Having a physical presence also 

supports the sales process. Before, 

thyssenkrupp’s lift division lacked a single 

building where it could demonstrate the 

range of its products. Now the tower 

serves as a showroom: Potential buyers 

can come to Rottweil, ride to the top, and 

examine the lift options in person. And 

the tower also earns money as an event 

space; local businesses frequently book 

the rooms at the top for meetings and 

activities. 

However, Hünger said that the most 

profound bene�ts of having invested in 

an iconic tower aren’t so immediately 

apparent. “What you cannot assess by 

looking at these numbers is the enormous 

image boost for thyssenkrupp as a brand,” 

she explained. Formerly, the company’s 

lift division was largely invisible to the 

public. (“You go into an elevator and ask 

yourself if you’ve seen the brand there,” 

Hünger pointed out.) The test tower’s 

unique architecture has given the division 

a very public identity, one that’s bold and 

forward-looking. “We love the fact that the 

tower fosters our image as a technology 

company and elevator manufacturer, 

instead of presenting thyssenkrupp solely 

as a steel supplier, as we are often 

perceived by the public.” 

And that also improves employee pride 

and helps to attract new talent. “It’s a hard 

competition here in Germany for all the 

engineers,” said Hünger, who also 

oversees the division’s research and 

development wing. “It’s a good way to 

show that we are innovative and investing 

in the future.”

The company has been so pleased with 

the outcome that it is planning something 

similar in the US. Thyssenkrupp has 

already broken ground on its North 

American headquarters in Atlanta. The 

campus will be accompanied by another 

architecturally distinct test tower, and 

thyssenkrupp hopes it will receive a 

similar level of attention and acclaim. 

The messages architecture 

can send

There’s nothing new about companies’ 

use of architecture to gain visibility or 

convey a particular set of values. Big 

corporations have long employed 

impressive buildings to highlight and 

elevate their status; those entrusted with 

the public’s money, such as banks and 

insurance companies, have often 

constructed imposing facades to indicate 

their seriousness and reliability. 

Iconic corporate architecture became 

particularly popular in the 1960s. In the 

US, for example, technology companies 

such as IBM and Bell Labs employed 

big-name modern architects such as Eero 

Saarinen and Charles and Ray Eames to 

design their buildings, underscoring the 

companies’ future orientation. 

Today, tech companies are still driving 

some of the trends in corporate 

architecture. Open plan o�ces, exposed 

brickwork, and whimsical features such 

as slides, for example, originated in IT 

o�ces and have now become so 

ubiquitous as to be clichés. More broadly, 

companies from a range of industries feel 

pressure to appear innovative and 

forward-thinking at a time when new 

technology in�uences ideas and products 

around the world.

But there’s been a key shift. These days, 

companies create distinctive facilities not 

simply to appeal to consumers, but to 

attract and retain key talent. 

“The architecture does need to convey 

a sense to the broader public, but the real 

focus is the user,” explained Paul De 

Santis, project designer for Zurich 

Insurance Group’s North America 

headquarters and partner with Goettsch 

Partners, an architecture �rm with o�ces 

in Abu Dhabi, Chicago, and Shanghai. 

“The idea that you’ll be able to attract the 

highest-quality people and retain 

‘There’s a generation of people 
looking to work for best-in-class 
companies, and they expect to be in 
best-in-class facilities.’
Paul De Santis, project designer for Zurich Insurance Group’s North America headquarters 
and partner with the architecture �rm Goettsch Partners
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high-quality sta� is a massive thing, no 

matter whether you’re in Germany or 

China or the US. And architecture plays a 

very big role in that. There’s a generation 

of people looking to work for best-in-class 

companies, and they expect to be in 

best-in-class facilities.”

Indeed, the US, Europe, Japan, and 

many other places are su�ering from 

intense labour shortages, particularly in 

industries that require specialised 

technical knowledge. Companies are 

competing for skilled workers — many of 

whom are seeking more than simply a 

nice paycheque. 

“People want to be proud of the place 

where they work,” said Matthias Hollwich, 

principal and co-founder of the New 

York-based architecture �rm HWKN. “It’s 

not just about making six �gures and 

driving a BMW — nobody cares about the 

BMW anymore, and with six �gures it’s 

like, ‘OK, but what else do you do?’ [The 

job] is also about lifestyle, quality of life, 

purpose.” And it doesn’t hurt, Hollwich 

added, if all of that can be documented on 

intensely image-focused social media.

Standout architecture can �ll many of 

those roles. That’s what the leaders of 

Suzlon Group, a global renewable energy 

company based in Pune, India, had in 

mind when they built a new headquarters 

in 2009. Named Suzlon One Earth and 

with a capacity to house 2,300 workers, 

the 10-acre campus boldly advertises the 

company’s values: It is LEED Platinum-

certi�ed and completely powered by 

renewable energy, with rainwater 

harvesting facilities and on-site waste 

conversion.

The company designed the campus to 

appeal to employees’ emotional and 

intellectual needs in order to inspire 

creativity and innovation in the 

workforce. 

The Leonardo Glass Cube in 
Bad Driburg, Germany, is the 
headquarters and showroom 
for German glassware company 
Glaskoch.
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But an inspiring facility can appeal to 

other important players as well: potential 

partners and clients.

 

The benefits of a modern glass cube

“You cannot have the same showroom 

you have had for 20 years and then tell 

people about the future,” said Oliver 

Kleine. The director and �fth-generation 

owner of Glaskoch Corporation, a German 

glassware company, explained why the 

160-year-old business built a new 

headquarters and showroom in 2007.

Around 2003, the company — which 

operates under the brand name Leonardo 

— began thinking about becoming a 

lifestyle company, with a broader product 

line that included furniture, tabletop 

items, and jewellery. That led to questions 

about the space that the company was 

using to show o� its goods. “We started to 

think about architecture because I don’t 

want to only speak about the future and 

the vision, but to show that people really 

can live it,” Kleine said. 

Kleine met the owners of 3deluxe, the 

architecture �rm that ultimately designed 

Glaskoch’s new space, at an exhibition 

and quickly felt a connection with them. 

At that time, 3deluxe was a young 

company that hadn’t yet created any 

permanent buildings. Kleine was willing 

to take a risk on its architects. “Somehow, 

I knew that when they were working on 

something for the �rst time, they would 

give much more of their passion than 

well-known architects, where you pay for 

the name,” he said. 

The result is the Leonardo Glass Cube, 

a 1,200-square-metre building in Bad 

Driburg, Germany, that combines 

naturalistic lines — think of a turtle shell’s 

design — with a lot of glass. It’s a 

stunning, unusual-looking facility that 

ultimately cost Glaskoch about €10 

million ($11.3 million). 

Kleine said it has been worth it. “I 

think everybody is quite proud of having 

such nice architecture,” he said, referring 

to Glaskoch’s 280 employees, who can 

enjoy the facility’s gleaming terrace on 

nice days. 

Just as important, the building has 

attracted a huge amount of public interest 

that — as in the case of thyssenkrupp — 

has bene�ted the company �nancially. 

“Every year, we have three or four 

commercial things happening here,” Kleine 

said. Movie scenes and advertisements 

have been �lmed in the glass cube, bands 

have held concerts, and other companies 

have used the space for expositions. Fees 

for use of the space, particularly in the case 

of crews shooting scenes for �lm and 

television, nearly cover the building’s 

overall operating costs, including heating, 

cooling, and electricity. 

But perhaps the greatest bene�t of 

having an ultramodern building is the 

impression it immediately conveys about 

the business. Kleine explained that back 

in 2009, the company was aiming to 

expand into furniture, and he and his 

colleagues met with other brands to 

discuss Glaskoch’s plans. 

“The �rst companies asked why we 

wanted to do it. We had to �nd a way to 

show them what our philosophy was, so 

we showed them this glass cube. And after 

that, there were no more questions,” he 

said. “It’s a very nice tool for new business 

development. They see the building, they 

like it very much, then they go inside and 

see what we’re doing, and very often 

they’re impressed. I don’t know how it 

would’ve been if we didn’t have the cube.”

Of course, Kleine has been lucky: Even 

after ten years, the building still looks 

modern and fresh. Aside from cost, that 

may be the other big downside to 

investing in unique architecture as a 

branding tool: Although not always true, a 

contemporary design could look dated 

after a few years and may no longer appeal 

to potential employees and clients or to 

the public. 

Still, for those that put in the time and 

calculations to get it right, great 

architecture can seriously pay o�.   Q

These days, companies create 
distinctive facilities not simply to 
appeal to consumers, but to attract 
and retain key talent.

Amanda Abrams is a freelance writer 

based in the US. To comment on this 

article or to suggest an idea for another 

article, contact Drew Adamek, an  

FM magazine senior editor, at  

Andrew.Adamek@aicpa-cima.com.



A free toolkit helps companies employ effective strategies 

to promote ethical practices within their supply chain.  

By Pauline Dibben, Ph.D.; John Cullen, FCMA, CGMA; Gareth Crockett, Ph.D.; 

Juliana Meira, Ph.D.; and Geoffrey Wood, Ph.D.

E
thical employment practices 

and resilient supply chains are 

essential ingredients of a 

reputable and sustainable 

business. Worker tragedies in 

emerging economies, such as the collapse 

of the Rana Plaza textiles factory in 

Bangladesh in 2013 that killed more than 

1,100 people, evidence of child labour in 

the production of mobile phones and 

batteries, and worker suicides at Foxconn 

in China, along with media coverage of 

those events, have made organisations 

increasingly aware of the need to know 

what happens down the supply chain and 

take responsibility for it. Failure to take 

responsibility can seriously undermine 

brand identity for many years, as many 

companies have discovered over time. 

The Supply Chain Accounting and 

Employment Practices (SCA-Emp) 

research team, a multinational 

collaboration of academics and industry 

representatives, found that few 

A tool to

strengthen

the supply chain 
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companies employ e�ective strategies to 

promote ethical practices within their 

supply chain. The research team, which 

received funding and guidance from 

CIMA, also found that many companies 

miss out on opportunities to employ 

accounting techniques that could make 

their supply chains more resilient. 

These �ndings were incorporated into 

the SCA-Emp Diagnostic Toolkit, which 

was designed to help accountants, human 

resources professionals, and supply chain 
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managers work together to ensure ethical 

HR and accounting practices within their 

organisation and throughout the supply 

chain. 

The toolkit was launched in 2016 and 

has been downloaded by companies in 

more than 20 countries.

What were the main findings?

The SCA-Emp project aimed to identify 

good practice and �nd out how (and 

whether) companies were checking on 

their suppliers’ practices. What were they 

doing inside the company? Did they 

monitor their suppliers? And did they 

promote labour standards? 

In 2014, the research team carried out 

a detailed survey of more than 100 

automotive and textile companies in 

Brazil and South Africa, involving major 

retailers, original equipment 

manufacturers, and �rst-, second-, and 

third-tier suppliers. It also drew on 

in-depth interviews with accounting and 

�nance managers, HR managers, CEOs, 

supply chain managers, trade unionists, 

professional bodies in accounting and 

HR, nongovernmental organisations, and 

employer organisations. 

We observed that, in practice, many 

companies have little knowledge of 

supplier behaviour. We found that many 

companies shared information with their 

customers and suppliers on 

manufacturing processes but not on costs 

or employment practices (such as 

training, recruitment, performance 

management, and diversity) unless a 

problem arose. Most companies (70% of 

those surveyed) had an equal 

opportunities policy within their own 

organisation, but we found limited 

transparency through the supply chain. 

Also, within the companies themselves, 

there was limited diversity in terms of the 

people employed, especially in 

management roles. 

In the automotive companies studied, 

knowledge of suppliers’ employment 

practices rapidly diminished as you 

moved down the supply chain. Although 

Brazilian automotive companies still had 

strategic alliances with tier-one suppliers, 

How to get the toolkit

The SCA-Emp toolkit is a free 
resource, available to download at 
www.sca-emp.com as an Excel file, 
or it can be completed online 
(registration is required).

The toolkit includes seven sections 
containing statements on supply 
chain management, employment 
practices, accounting, and monitoring 
of suppliers. It is a self-evaluation 
tool that includes suggested actions. 
The online version provides users 
with a report based on their 
responses.

To find out more about the 
research project or the toolkit, email 
Pauline Dibben at p.dibben@sheffield.
ac.uk. 
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cost-cutting pressures had led to 

arm’s-length contracting further down the 

supply chain, particularly when sourcing 

from companies in Asia. 

In South Africa, tier-one suppliers were 

heavily involved in the �nal production 

process, but outsourcing had meant that 

workers were often given inferior 

employment conditions. In clothing and 

textiles �rms, jobs were much more likely 

to be short-term, with problems around 

health and safety, and a lack of e�ective 

worker voice. In rural areas, self-employed 

workers were used, though they were not 

monitored by the government or taxed. 

The sector as a whole was struggling to 

survive, due to the availability of cheap 

imports from China and South Asia.

These �ndings helped to inform the 

SCA-Emp Diagnostic Toolkit.

What accountants can do to 

promote resilient supply chains 

Our research suggests that many 

organisations miss out on important 

opportunities to make their supply chains 

more resilient. Finance professionals can 

play an important role in helping their 

organisation achieve this goal by:

yyy Identifying ways that their skills can 

complement those of procurement 

and supply chain colleagues, 

and working together to explore 

those opportunities. For instance, 

accountants are able to bring 

their diagnostic skills, using tools 

such as open book accounting 

or make-or-buy, to inform other 

colleagues of the costs and bene�ts 

associated with di�erent scenarios. 

The accounting section of the 

SCA-Emp toolkit can help identify 

ways to do this.

yyy Encouraging other colleagues and 

departments to get involved in the 

supply chain as well and to use the 

toolkit as a strategy planner. For 

instance, HR practitioners bring 

skills around con�ict resolution, 

which can help identify the best 

course to take if industrial action 

such as strikes a�ect the supply 

chain. They might also be able to 

help interpret data on suppliers’ 

employment practices with the 

intention of identifying potential 

instances of labour exploitation and 

therefore help prevent the risk of 

damage to brand image.

yyy Trying to build strong relationships 



FM-MAGAZINE.COM  June 2019  I  FM MAGAZINE  I  51

Pauline Dibben, Academic FCIPD, 
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with customers and suppliers. Our 

research suggests that long-term, 

trusting relationships between 

customers and suppliers boost 

competitive advantage for both. 

Sharing �nancial data between 

customers and suppliers (eg, by 

using open book accounting) 

can help to identify cost savings 

and prevent unexpected supply 

interruptions.

��y Not being afraid to ask customers 

or suppliers for employment 

information. We found that many 

�rms share data on production 

processes or product speci�cation, 

but they rarely inform one another 

about labour costs and practices. 

This can help to highlight instances 

where workers are not being treated 

well — for example, by being paid 

less than the minimum wage. 

Sharing this type of information 

relies on trust, which can take 

time to build, but you can start 

small. You don’t need to share 

con�dential information to make 

improvements. For example, after 

using the toolkit, an agricultural 

business in South Africa with fewer 

than 100 employees introduced 

more professional procurement 

practices (eg, taking into account 

cash �ow management issues), and 

this enabled the business to create 

better relationships with suppliers 

and develop more sophisticated 

production practices. 

��y Using the checklist in the SCA-Emp 

toolkit to help to evaluate current 

suppliers or to aid supplier selection. 

The toolkit can be used as part of 

the assessment criteria to create a 

preferred supplier list. Some �rms 

have used the toolkit to integrate a 

more ethical dimension into their 

sourcing policy by asking suppliers 

to complete the toolkit at the point 

of registration and to review it at 

regular intervals. The completion of 

the toolkit by suppliers is an integral 

part of identifying and promoting 

best practices with preferred 

suppliers.

How to use the toolkit

The toolkit will appeal to companies and 

practitioners that wish to improve the 

competitiveness and resilience of their 

supply chain and to those keen to prevent 

damage to their brand that could arise if 

poor labour standards in supplier �rms 

are exposed.

Companies can use the toolkit to check 

current practices within the �rm, to plan 

strategy across departments, or to 

benchmark existing suppliers and 

evaluate potential suppliers. 

Results obtained by toolkit users 

Examining the aspects of the business 

highlighted in the toolkit has helped 

organisations around the world tackle 

several performance issues. 

Organisations from across the world 

have used the toolkit to: 

��y Increase employee productivity and 

pro�ts; 

��y Improve communication with 

employees and relationships with 

customers and suppliers;

��y Enhance their focus on ethics and 

quality; 

��y Improve knowledge of the supply 

chain and work toward better 

integration of departments within 

the organisation; and

��y Embed forms of best practice 

throughout the organisation. 

An automotive company in Brazil has 

drawn on ideas from the toolkit to 

promote its performance appraisal 

system, improve bene�ts and training 

for employees, and enhance interaction 

between the accounting and commercial 

team. Between December 2016 and 2017, 

it developed better relationships with 

customers and saw an increase of around 

7% in productivity, 5% more business, and 

a 2% increase in pro�ts. Company 

directors informed us that they 

attributed much of this improvement to 

their use of the toolkit. A second 

automotive company in Brazil is now 

modelling best practice to other 

automotive companies, and during a 

time of economic crisis, managers felt 

that their experience using the toolkit 

helped them to maintain a focus on 

ethics, values, and strategy.

A large UK local authority uses the 

toolkit as a central part of its ethical 

procurement strategy. The initial phase 

of this process focuses on its largest 

suppliers and will then be rolled out to 

its smaller suppliers. The toolkit will 

then subsequently be used to assess 

potential new suppliers.   Q

Finance professionals can help make 
the supply chain more resilient by 
building relationships with 
customers and suppliers.
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When scouting for high-potential talent, 

the first place to look could be in-house. 

By Hannah Pitstick

Watch for these 

signs to spot
your rising stars 
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A
s �nance and accounting 

teams experience talent 

shortages, due in part to the 

retirement of Baby Boomers, 

limited applicant pools, and 

a rising demand for new technology skills, 

many are �nding it more di�cult than 

ever to spot and nurture the next crop of 

leaders. 

“There’s a war for talent on a global 

basis,” said Gareth El Mettouri, associate 

director at Robert Half UAE, a human 

resource consulting organisation.

In order to compete, an increasing 

number of companies are setting up 

“talent factories”, which Doug Ready, a 

senior lecturer at the MIT Sloan School of 

Management, de�nes as pipelines of 

high-potential employees that “marry 

functionality, or rigorous talent processes 

that support strategic and cultural 

objectives, and vitality, meaning 

emotional commitment from 

management that is re�ected in daily 

actions”.

These pipelines can help ensure a 

steady supply of talented individuals are 

ready to �ll leadership roles, but even 

when the talent you are looking for is 

already in-house, you still have to know 

how to spot them. That can be challenging 

because the most desirable qualities of 

future leaders are constantly shifting and 

becoming increasingly elusive. 

A
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As Claudio Fernández-Aráoz wrote in a 

2014 Harvard Business Review article, 

“21st-Century Talent Spotting”, 

organisations and their leaders must 

transition to a new era in the hunt for 

stars, “one in which our evaluations of 

one another are based not on brawn, 

brains, experience, or competencies, but 

on potential”, which he de�ned as the 

ability to adapt to and grow into 

increasingly complex roles and 

environments. It’s not all about hard skills 

anymore — those skills must be paired 

with experience, soft skills, and fresh 

perspectives.

Finding the �nance leaders of the future 

early has never been more important. A 

wise �nance leader will build an e�ective 

team around them and constantly be 

spotting potential talent. Often, that talent 

is already working for you. Here are four 

things to look out for to identify the rising 

stars on your �nance team:

Catalytic learning capabilities
Rising stars are always learning, and 

because business models are changing 

all the time and new competition is 

always lurking around the corner, 

up-and-coming leaders must be 

comfortable operating in a continuous 

learning mode.

When assessing team members for 

potential leadership possibilities, look for 

employees who voluntarily take on 

additional courses, attend conferences, 

and acquire valuable certi�cates in key 

areas. 

“You need folks who have almost an 

intrinsic sense of curiosity, or what I like 

to call catalytic learning capability,” Ready 

said. “In other words, they’re able to 

absorb a lot, learn from it, and catalyse 

that learning into productive value for 

customers.” These are employees who are 

curious enough to look around for trends, 

are always embracing change, and are 

perennial learners.

Resilience
A high-potential professional is willing to 

try new things and is resourceful when 

placed in unfamiliar situations. The great 

ones are those who, even when they run 

into a roadblock, consider that roadblock 

temporary and pivot to the future, 

according to Ready. Look for team 

members who display creative  

problem-solving and are relentless in 

their pursuit of trying to improve things 

for both the customer and the company. 

“The high potentials are the ones who 

want to see that direct linkage between 

their contributions and productive 

outcomes,” Ready said. “They want clarity 

about what the big challenges facing their 

company are and how they can help.”

Rising stars are also extremely 

interested in feedback — praise as well as 

developmental feedback that can help 

them get better. When looking for rising 

stars, watch for resilient individuals who 

seek out feedback and can take criticism 

and use it to improve their performance. 

Data and tech skills
Advances in technology are changing the 

nature of opportunities available in 

�nance, according to James Brent, a 

UK-based senior business director at 

Hays, a global recruiting company. You 

should be looking for individuals who 

embrace this change and adapt to new 

innovations in the market. 

“There is increased appetite for 

accountants and �nance professionals 

who can also work as business analysts 

and data scientists and use their 

technology skills to their advantage to 

further their career,” he said. 

Individuals with a background in 

analysis or data science, or those who are 

eager to learn those �elds, are likely 

candidates for leadership. 

“A leader needs to have, at a 

minimum, a deep appreciation for the 

power of analytics in order to drive a 

strategy that’s based on analytics,” Ready 

said. “It means understanding the power 

of analytics, big data, and the practical 

applications of arti�cial intelligence and 

machine learning. You can’t just relegate 

that to young people down at the bottom 

of the hierarchy.”

Diverse perspectives
It is vital to ensure that your company is 

developing a talent pipeline that re�ects 

your customer base, and if your current 

leadership only represents one subset of 

the population, you should be looking 

for talent with new and di�erent 

perspectives that can help keep your 

company in touch with the modern era 

and maintain a fresh wellspring of ideas. 

Diverse talent with experience in a 

variety of work environments across 

both global cultures and company 

functions are likely candidates for 

leadership. 

There is a lot of consolidation 

happening, El Mettouri said, and 

candidates who have experience working 

in a variety of environments are better 

prepared to �nd solutions that work well 

in speci�c contexts. 

You should be looking for talented 

individuals who have already taken, or 

are willing to take, work assignments in 

foreign countries, as well as individuals 

who have a lifetime of experience as an 

underrepresented minority in the �eld. 

“If your business is globalising and 

your customers are increasingly diverse, 

you had better have people in your 

organisation that are increasingly diverse 

so they at least have a better chance of 

understanding customer preferences,” 

Ready said.    Q

‘They want clarity about what the 
big challenges facing their company 
are and how they can help.’
Doug Ready, a senior lecturer at the MIT Sloan School of Management, on high potentials

Hannah Pitstick is a freelance writer 

based in the US. To comment on this 

article or to suggest an idea for another 

article, contact Drew Adamek, an  

FM magazine senior editor, at  

Andrew.Adamek@aicpa-cima.com.  
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Taking stock of 
corporate travel 

Sponsored Report

Sponsored by

SAP Concur  •  The Access Group

Experts discuss how to best approach, and monitor, 

travel and expense reimbursements.  
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W
KHWKHU�LW·V�D�ODVW�PLQXWH�LQWHUQDWLRQDO�WULS�

WR�ÀQDOLVH�D�GHDO��GLQQHUV�DW�XSPDUNHW�

VWHDNKRXVHV�IRU�OR\DO�FOLHQWV��RU�KRWHO�

URRPV�IRU�D�SURIHVVLRQDO�FRQIHUHQFH��

WUDYHO�DQG�UHODWHG�FRVWV�FDQ�WDNH�XS�D�

KHDOWK\�FKXQN�RI�D�FRPSDQ\·V�ERWWRP�OLQH��

:LWK�LQFUHDVLQJ�QXPEHUV�RI�UHPRWH�ZRUNHUV�DQG�

D�JOREDO�EXVLQHVV�HQYLURQPHQW��EXVLQHVV�WUDYHO�LV�D�

IRUHJRQH�FRQFOXVLRQ��HYHQ�DV�WHFKQRORJLHV�KDYH�PDGH�

YLUWXDO�PHHWLQJV�DQG�LQWHUDFWLRQ�EHWZHHQ�IDU�ÁXQJ�

DVVRFLDWHV�HDV\��&RPSDQLHV�FDQ�EHQHÀW�E\�VFUXWLQLVLQJ�

WKHLU�WUDYHO�H[SHQVH�SURFHVV�DQG�ÀQGLQJ�ZD\V�WR�HQVXUH�

WKH\·UH�JHWWLQJ�WKH�EHVW�SULFHV�DQG�DQWLFLSDWLQJ�IXWXUH�

FRVWV�ZKLOH�GLVFRXUDJLQJ�HPSOR\HHV�IURP�WDNLQJ�XQIDLU�

DGYDQWDJH�RI�WUDYHO�UHLPEXUVHPHQW�SROLFLHV��H[SHUWV�VD\��

2XWVLGH�WUDYHO�PDQDJHPHQW�JURXSV�RU�HPSRZHUHG� 

LQ�KRXVH�ÀQDQFH�WHDPV�FDQ�ZRUN�WR�QHJRWLDWH�VSHFLDO�

UDWHV�ZLWK�DLUOLQHV��KRWHO�FKDLQV��FDU�UHQWDO�ÀUPV��DQG�

PRUH��VDLG�:LOO�7DWH��&3$��D�SDUWQHU�DQG�EXVLQHVV�

SURFHVV�H[SHUW�DW�*ROG6SULQJ�&RQVXOWLQJ�RXWVLGH�RI�

'DOODV��ZKLFK�DVVLVWV�FRUSRUDWLRQV�LQ�HYDOXDWLQJ�DQG�

PDQDJLQJ�WKHLU�WUDYHO�H[SHQVHV��$�ZHOO�PDQDJHG�

FRUSRUDWH�WUDYHO�SURJUDPPH�FRXOG�UHVXOW�LQ�XS�WR�����

VDYLQJV�ZLWKLQ�D�\HDU�RU�WZR�RI�LPSOHPHQWDWLRQ��7DWH�

HVWLPDWHV��HVSHFLDOO\�IRU�FRPSDQLHV�WKDW�VSHQG����PLOOLRQ�

D�\HDU�RU�PRUH�RQ�WUDYHO��

´,W·V�JRRG�PRQH\�µ�KH�VDLG��DERXW�WKH�SRWHQWLDO�VDYLQJV��

7KRVH�VDYLQJV�DUH�DFKLHYHG�LQ�ODUJH�SDUW�E\�GHHS�

DQDO\VLV�RI�SDVW�WULSV�DQG�LQWHQWLRQDO�HIIRUWV��HLWKHU�ZLWK�

FRQVXOWDQWV�RU�WKURXJK�LQ�KRXVH�UHYLHZV��WR�DGMXVW�WUDYHO�

EHKDYLRXUV�RI�HPSOR\HHV�WR�ZKLWWOH�GRZQ�FRVWV��KH�VDLG��

$GMXVWLQJ�EHKDYLRXUV�FRXOG�LQYROYH�SROLFLHV�WKDW�SUHVHUYH�

WKH�FRPIRUW�DQG�HDVH�RI�WUDYHO�ZKLOH�LQFHQWLYLVLQJ�ORZHU�

SULFHV��

COST NOT SOLE FOCUS

:KLOH�FRVW�VDYLQJV�DUH�VWLOO�D�WRS�SULRULW\�IRU�PRVW�

SURFXUHPHQW�RIÀFHV��LW·V�QRW�WKH�RQO\�FRQVLGHUDWLRQ��

DFFRUGLQJ�WR�DQ�DQDO\VLV�RI�FRUSRUDWH�WUDYHO�WUHQGV�E\�

3KRFXVZULJKW��D�GDWD�DQG�DQDO\VLV�FRPSDQ\�IRU�WKH�WUDYHO�

DQG�KRVSLWDOLW\�LQGXVWU\�

$�UHFHQW�IRUZDUG�ORRNLQJ�UHSRUW�RQ�WUHQGV�LQ�86�

FRUSRUDWH�WUDYHO�IRXQG�����RI�WUDYHO�PDQDJHUV�OLVWHG�

FRVW�DV�D�WRS�VWUDWHJLF�SULRULW\��ZKLOH�����VDZ�WKH�

ZHOOEHLQJ�DQG�VDWLVIDFWLRQ�RI�WUDYHOOLQJ�VWDII�DV�D�PDMRU�

JRDO��2WKHU�WRS�JRDOV�ZHUH�NHHSLQJ�WUDYHOOLQJ�HPSOR\HHV�

VDIH��HQKDQFLQJ�GDWD�FDSDELOLWLHV��DQG�LPSURYLQJ�SROLF\�

FRPSOLDQFH��

7DWH�VDLG�FRPSDQLHV�QHHG�WR�EH�FOHDU�DERXW�WKHLU�

SULRULWLHV�ZKHQ�VHHNLQJ�RXW�WKLUG�SDUWLHV�WR�PDQDJH�WUDYHO�

SURJUDPPHV��,I�D�QHZ�WUDYHO�DJHQF\�ÀQGV�VLJQLÀFDQW�

VDYLQJV�ZLWK�FKHDSHU�ÁLJKWV�EXW�HPSOR\HH�PRUDOH�LV�

KDUPHG�E\�ERRNHG�ÁLJKWV�WKDW�OHDYH�DW�LQFRQYHQLHQW�

WLPHV�ZLWK�PXOWLSOH�WUDQVIHUV��DQ\�VDYLQJV�PD\�EH�RIIVHW�

E\�WKH�GUDLQ�RQ�VWDII��KH�VDLG���)RU�D�GLVFXVVLRQ�RI�KRZ�

RUJDQLVDWLRQV�FDQ�EDODQFH�VRXQG�SROLFLHV�ZLWK�HPSOR\HH�

ZHOOEHLQJ��VHH�WKH�VLGHEDU��´0L[LQJ�5XOHV�:LWK�&KRLFHV�

0D\�%H�WKH�%HVW�7UDYHO�3ROLF\µ��

0RVW�FRPSDQLHV�DOUHDG\�KDYH�D�ZHDOWK�RI�LQIRUPDWLRQ�

DW�WKHLU�GLVSRVDO��ZLWK�SDVW�WULSV�RIIHULQJ�LQVLJKW�LQWR�

DYHUDJH�WULS�FRVWV��UHVWDXUDQWV�RU�DLUOLQHV�IUHTXHQWHG��

DQG�PRUH��%\�FRQVROLGDWLQJ�GDWD�DFURVV�D�FRPSDQ\�

RU�GLYLVLRQ��WUDYHO�EX\HUV�FDQ�JHW�LQVLJKWV�LQWR�WKRVH�

H[SHQVHV�DQG�LGHQWLI\�SODFHV�IRU�VDYLQJV��7DWH�VDLG��

'DWD�DQDO\VLV�FDQ�WKHQ�EH�XVHG�LQ�ELGV�ZLWK�SURYLGHUV�WR�

QHJRWLDWH�EHWWHU�UDWHV�DQG�DOORZ�H[HFXWLYHV�WR�DGGUHVV�

DEHUUDWLRQV��)RU�H[DPSOH��D�FORVH�ORRN�DW�SDUNLQJ�FRVWV�

FRXOG�VKRZ�HPSOR\HHV�H[SHQVLQJ�SUHPLXP�DPRXQWV�WR�

SDUN�LQ�FDU�SDUNV�FORVHVW�WR�WKH�DLUSRUW�IRU�ZHHNORQJ�WULSV�

DQG�SURPSW�D�SROLF\�FKDQJH�WR�HQFRXUDJH�WKH�XVH�RI�

UHPRWH�FDU�SDUNV�RU�SDUN�DQG�ULGH�VHUYLFHV��

FRAUD A FOCUS

)RU�WKRVH�WDVNHG�ZLWK�PRQLWRULQJ�FRPSDQ\�WUDYHO�

SURJUDPPHV��WKHUH·V�DOVR�D�QHHG�WR�VHW�XS�SROLFLHV�

DQG�LQWHUQDO�FRQWUROV�WR�GLVFRXUDJH�IUDXGXOHQW�

UHLPEXUVHPHQWV��VDLG�&HFLOLD�/RFDWL��)&0$��&*0$��

RZQHU�RI�WKH�FRQVXOWLQJ�ÀUPV�,QWHUQDO�&RQWURO�7RROER[�

DQG�)UDXG�)HQFH��7KDW�LQFOXGHV�FRQGXFWLQJ�UHJXODU�

DXGLWV��ZKLFK�QRW�RQO\�FDQ�GHWHFW�SUREOHPDWLF�H[SHQVHV�

EXW�DOVR�FDQ�VHUYH�DV�D�SUHYHQWLYH�PHDVXUH��.QRZOHGJH�

WKDW�H[SHQVHV�ZLOO�EH�VFUXWLQLVHG�LV�RIWHQ�HQRXJK�WR�GHWHU�

IUDXGXOHQW�EHKDYLRXU��/RFDWL�VDLG��

,QWHUQDO�DXGLWV�´FDQ�EH�YHU\�HIIHFWLYH�LI�>FRPSDQLHV@�

KDYH�DOO�WKH�GDWD�LQ�WKH�VRIWZDUHµ��VDLG�/RFDWL��ZKR�

KDV�ZRUNHG�ZLWK�FRPSDQLHV�DURXQG�WKH�JOREH�WR�

VWUXFWXUH�EXVLQHVV�WUDYHO�SURJUDPPHV��ZLWK�D�IRFXV�RQ�

GLVFRXUDJLQJ�HPSOR\HH�IUDXG��

([SHQVH�UHLPEXUVHPHQW�VFKHPHV�UHPDLQ�D�VLJQLÀFDQW�

SHUFHQWDJH�RI�RFFXSDWLRQ�UHODWHG�IUDXG�ZRUOGZLGH��

PDNLQJ�XS�����RI�WKH�QHDUO\�������IUDXGXOHQW�FDVHV�

H[DPLQHG�IRU�D������UHSRUW�RQ�RFFXSDWLRQDO�IUDXG�E\�WKH�

$VVRFLDWLRQ�RI�&HUWLÀHG�)UDXG�([DPLQHUV��$&)(��

1RU�LV�WKH�FRVW�RI�WKRVH�PLVGHHGV�LQVLJQLÀFDQW��ZLWK�DQ�

DYHUDJH�UHSRUWHG�ORVV�RI���������IRU�LVVXHV�WKDW�ODVWHG�DQ�

DYHUDJH�RI�WZR�\HDUV�EHIRUH�GHWHFWLRQ��DFFRUGLQJ�WR�WKH�

$&)(�UHSRUW�

7KH�LQGXVWULHV�PRVW�OLNHO\�WR�H[SHULHQFH�WKLV�W\SH�RI�

IUDXG�ZHUH�FKDULWDEOH�DQG�UHOLJLRXV�RUJDQLVDWLRQV�DQG�WKH�

SURIHVVLRQDO�VHUYLFHV�LQGXVWU\��ZKLOH�WKH�EDQNLQJ�LQGXVWU\�

VDZ�WKH�ORZHVW�UDWHV��DFFRUGLQJ�WR�WKH�$&)(�UHSRUW��

7KDW·V�OLNHO\�EHFDXVH�QRQJRYHUQPHQWDO�RUJDQLVDWLRQV�

DQG�FKDULWLHV�PD\�KDYH�ZHDNHU�LQWHUQDO�FRQWUROV��

ZKLOH�EXVLQHVVHV�LQ�WKH�FORVHO\�UHJXODWHG�EDQNLQJ�
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LQGXVWU\�WHQG�WR�KDYH�VWULFW�SURFHVVHV�WKURXJKRXW�WKHLU�

RUJDQLVDWLRQV��/RFDWL�VDLG��6KH�VDLG�IUDXG�LV�FRPPRQ�DW�

RUJDQLVDWLRQV�ZLWK�SRRU�LQWHUQDO�FRQWUROV�DV�ZHOO�DV�WKRVH�

ZKHUH�DQWL�IUDXG�SROLFLHV�DUH�QRW�LQ�SODFH��HQIRUFHG��RU�

FRPPXQLFDWHG�

,QWHUHVWLQJO\��VPDOOHU�FRPSDQLHV�³�WKRVH�ZLWK�IHZHU�

WKDQ�����HPSOR\HHV�³�ZHUH�OLNHO\�WR�KDYH�PRUH�LVVXHV�

ZKHQ�LW�FRPHV�WR�H[SHQVHV�IUDXG��WKH�VWXG\�IRXQG��

/DUJHU�FRPSDQLHV��VKH�VDLG��DUH�PRUH�OLNHO\�WR�LQYHVW�LQ�

VRIWZDUH�WR�PRQLWRU�H[SHQVHV�DQG�KDYH�FOHDU�SROLFLHV�VR�

HPSOR\HHV�NQRZ�ZKDW�LV�DQG�LVQ·W�DOORZHG��

:LWK�SOHQW\�RI�PRQH\��DQG�ULVN��RQ�WKH�OLQH��KHUH�DUH�

DGGLWLRQDO�WLSV�RQ�KRZ�WR�EHVW�PDQDJH�DQG�PRQLWRU�D�

FRUSRUDWH�WUDYHO�SROLF\��

Hammer out a policy

+DYLQJ�D�FOHDU�FRUSRUDWH�SROLF\�VWDWLQJ�KRZ�HPSOR\HHV�

VKRXOG�ERRN�ZRUN�UHODWHG�WUDYHO�³�ZKHWKHU�RQ�WKHLU�

RZQ�RU�WKURXJK�DQ�DSSURYHG�EXVLQHVV�WUDYHO�SODWIRUP�

³�DQG�VHHN�UHLPEXUVHPHQW�FDQ�KHOS�FRPSDQLHV�UHLQ�LQ�

H[RUELWDQW�FRVWV��/RFDWL�VDLG��6KH�VXJJHVWV�NHHSLQJ�DQ\�

SROLFLHV�WR�D�IHZ�SDJHV�WR�LQFUHDVH�FRPSOLDQFH�DPRQJ�

VWDII��´7KH�ORQJHU�WKH\�DUH��WKH�OHVV�WKH\�DUH�UHDG�µ�VKH�

VDLG��&RQVLGHUDWLRQV�WR�LQFOXGH�DUH�ZKHWKHU�WR�UHTXLUH�

SUH�DSSURYDOV�IRU�WULSV�WKDW�H[FHHG�D�FHUWDLQ�SULFH��

JXLGDQFH�RQ�KRZ�FRUSRUDWH�FUHGLW�FDUGV�FDQ�EH�XVHG��DQG�

ZKHWKHU�HPSOR\HHV�FDQ�H[SHQVH�WKLQJV�OLNH�DOFRKRO�RU�

HQWHUWDLQPHQW�FRVWV��)RU�ÁLJKW�ERRNLQJV��LQGLFDWH�ZKHQ�RU�

LI�EXVLQHVV�FODVV�WLFNHWV�DUH�DSSURSULDWH�DQG�LI�HPSOR\HHV�

QHHG�WR�ERRN�WKH�FKHDSHVW�ÁLJKWV�DYDLODEOH��RU�LI�WKHUH�LV�

ÁH[LELOLW\�WR�RSW�IRU�SULFLHU�ÁLJKWV�LI�WKHUH�DUH�IHZHU�OHJV�RU�

PRUH�FRQYHQLHQW�GHSDUWXUH�WLPHV��

Drill down for details

:KHQ�LW�FRPHV�WR�RXW�RI�RIÀFH�H[SHQVHV��LW·V�LPSRUWDQW�

WR�EH�FOHDU�DERXW�ZKDW�WKH�FRPSDQ\�ZLOO�DQG�ZRQ·W�FRYHU��

/RFDWL�VDLG��&RPSDQLHV�WKDW�GR�KDYH�UHVWULFWLRQV�RQ�

FHUWDLQ�SXUFKDVHV�VKRXOG�PDNH�VXUH�H[SHFWDWLRQV�DUH�

FOHDU�DQG�WKHQ�H[DPLQH�LWHPLVHG�ELOOV�RI�KRWHO�FKDUJHV��

6RPH�PD\�WU\�WR�VOLS�LQ�H[SHQVHV�³�OLNH�WKH�H[SHQVLYH�

VQDFNV�RU�GULQNV�LQ�WKH�PLQL�EDU�³�DQG�UHTXLULQJ�LWHPLVHG�

ELOOV�ZLOO�OLNHO\�GLVFRXUDJH�DQ\�H[WUDQHRXV�H[SHQVHV��´,W·V�

XS�WR�WKH�FRPSDQ\�WR�GHFLGH�KRZ�PDQ\�EHQHÀWV�WKH\�

ZDQW�WR�JLYH�WR�WKH�HPSOR\HHV�µ�VKH�VDLG��

Consider per diems

6RPH�HPSOR\HUV�FKRRVH�WR�VNLS�WKH�KHDGDFKHV�RI�

UHTXLULQJ�UHFHLSWV�WR�SURYH�SXUFKDVHV�DQG�LQVWHDG�RSW�

IRU�SHU�GLHP�DOORZDQFHV�RU�KDYH�SHU�GLHP�OLPLWV�EDVHG�

RQ�ORFDWLRQ��%\�KDYLQJ�D�VHW�UDWH�IRU�PHDOV�RU�RWKHU�

H[SHQVHV��LW�FDQ�DOORZ�WUDYHO�PDQDJHUV�WR�SUHGLFW�ZHOO�

DKHDG�RI�WLPH�KRZ�PXFK�WKH\·OO�EH�VSHQGLQJ�RQ�WUDYHO��

6RPH�ODUJH�FRPSDQLHV�KDYH�FDOFXODWHG�ZKDW�DQ�DYHUDJH�

FRVW�PD\�EH�IRU�D�EXVLQHVV�WULS�WR�D�SDUWLFXODU�FLW\��VD\�

�������IRU�WKUHH�GD\V�LQ�:DVKLQJWRQ��DQG�WKHQ�JLYH�WKH�

HPSOR\HHV�WKDW�DPRXQW�GLUHFWO\�DQG�OHDYH�WKH�GHWDLOV�XS�

WR�WKHP��,W�FDQ�DOVR�EH�D�ERRVW�IRU�HPSOR\HHV��OHDYLQJ�

WKHP�WKH�RSWLRQ�RI�FKRRVLQJ�ZKHWKHU�WR�VSHQG�WKHLU�ZKROH�

SHU�GLHP��RU�WR�HDW�RQ�WKH�FKHDS�DQG�SRFNHW�WKH�UHVW��

/RFDWL�VDLG��,W�PD\�QRW�QHFHVVDULO\�PHDQ�D�VDYLQJV��EXW�

KDYLQJ�WRS�SHUIRUPHUV�IHHO�FRQWHQW�FDQ�JR�D�ORQJ�ZD\��

Separate pleasure and business

7KHUH·V�DQ�XSWLFN�LQ�WKH�WUDYHO�LQGXVWU\�RI�ZKDW·V�NQRZQ�

DV�´EOHLVXUH�µ�D�EOHQGLQJ�RI�ZRUN�UHODWHG�DQG�SHUVRQDO�

WUDYHO�ZKHUH�WUDYHOOLQJ�VDOHV�SHRSOH�RU�RWKHUV�WDFN�RQ�D�

IHZ�GD\V�WR�VSHQG�D�ZHHNHQG�LQ�DQ�DWWUDFWLYH�ORFDWLRQ��

,W·V�LPSRUWDQW�WR�EH�FOHDU�DERXW�KRZ�WR�KDQGOH�WKRVH�W\SHV�

RI�DUUDQJHPHQWV��VDLG�'DYLG�$QGHUVRQ��&3$��ZKR�KHDGV�

D�IRUHQVLF�DFFRXQWLQJ�ÀUP�LQ�3KLODGHOSKLD��$QGHUVRQ��

ZKR�JHQHUDOO\�DGYLVHV�DJDLQVW�PL[LQJ�SURIHVVLRQDO�DQG�

SHUVRQDO�WUDYHO��JDYH�WKH�H[DPSOH�RI�DQ�H[HFXWLYH�ZKR�

JDLQHG�SHUPLVVLRQ�WR�EX\�D�VSRXVH�D�SODQH�WLFNHW�RQ�D�

FRUSRUDWH�FDUG�ZLWK�WKH�SURPLVH�RI�SD\LQJ�WKH�FRPSDQ\�

EDFN��6XFK�DQ�DJUHHPHQW�UHTXLUHV�VRPHRQH�WR�PDNH�

VXUH�WKH�PRQH\�LV�SDLG�EDFN�DQG�DFFRXQWHG�IRU�FRUUHFWO\��

+DYLQJ�FOHDU�SROLFLHV�WKDW�DGGUHVV�KRZ�FRVWV�ZLOO�EH�

Mixing rules with choices may 
be the best travel policy

WKLOH�D�ZHOO�FRQVWUXFWHG�WUDYHO�DQG�H[SHQVH�

SROLF\�ZLOO�KROG�HYHU\RQH�DFFRXQWDEOH�WR�

WKH�VDPH�VHW�RI�UXOHV��SURYLGLQJ�VRPH�OHYHO�RI�

ÁH[LELOLW\�WR�DFFRPPRGDWH�SHUVRQDO�WDVWHV�FDQ�OHDG�

HPSOR\HHV�WR�EH�PRUH�VDWLVÀHG�

7KH�DYDLODELOLW\�RI�FKRLFHV�ZDV�D�NH\�IDFWRU�

LQ�WUDYHOOHU�VDWLVIDFWLRQ�LQ�D������VXUYH\�RI�

������IUHTXHQW�EXVLQHVV�WUDYHOOHUV�LQ�$XVWUDOLD��

&DQDGD��WKH�8.��DQG�WKH�86�FRQGXFWHG�E\�LQYRLFH�

DXWRPDWLRQ�VXSSOLHU�&KURPH�5LYHU��$PRQJ�WUDYHOOHUV�

ZKR�LGHQWLÀHG�WKHPVHOYHV�DV�´YHU\�VDWLVÀHGµ�

�Q �����ZHUH�SHUPLWWHG�WR�WUDYHO�RQ�WKH�DLUOLQH�RI�

WKHLU�FKRLFH�

�Q �����ZHUH�DOORZHG�WR�FKRRVH�WKHLU�KRWHO�

�Q �����VDLG�WKH\�FRXOG�VHOHFW�WKHLU�FDU�UHQWDO�ÀUP�

6R��ZKLOH�D�SROLF\�WKDW�KROGV�HYHU\RQH�DFFRXQWDEOH�

PLJKW�UHTXLUH�WKDW�DOO�HPSOR\HHV�Á\�LQ�HFRQRP\�UDWKHU�

WKDQ�LQ�EXVLQHVV�FODVV��DOORZLQJ�WUDYHOOHUV�WR�SLFN�WKHLU�

RZQ�DLUOLQH��ZLWKLQ�UHDVRQ��GHSHQGLQJ�RQ�IDUHV��PLJKW�

FRQWULEXWH�WR�HPSOR\HH�VDWLVIDFWLRQ�
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Dafydd Llewellyn
Managing Director, EMEA 
SMB & Nationals
SAP Concur

Since joining in 2004, Dafydd 

Llewellyn has played a key role in 

developing the UK business —  

helping growing companies to 

transform their manual expense, 

travel, and invoice processes.   

For more than two decades, SAP 

Concur has taken companies of all 

sizes and stages beyond automation 

to a completely connected spend 

management solution encompassing 

travel, expense, invoice, compliance, 

and risk. 

Cracking expense compliance

Q What exactly is meant by expense compliance?    

A Expense compliance can be internal and external. Internal compliance 

refers to employees within a business following travel and expense (T&E) 

rules prescribed by company policy. Both intentional and unintentional errors 

DUH�LGHQWLÀHG�DQG�DGGUHVVHG�WR�KHOS�WKH�EXVLQHVV�DFKLHYH�JUHDWHU�FRPSOLDQFH��

([WHUQDO�FRPSOLDQFH�FRQFHUQV�D�FRPSDQ\·V�DGKHUHQFH�WR�VWDWXWRU\�DQG�+05&�

regulations governing business practices and taxes. This could be examined by 

LQWHUQDO�DXGLWLQJ�WHDPV�RU�WKH�+05&�´WD[�PDQµ��

Q How do you tackle internal compliance?  

A Strong internal compliance begins with good policies. These must be 

company-wide and include details of what can and cannot be claimed for, travel 

guidelines, mileage/fuel rates, and personal expenditure. Policy only helps to a 

point though; you need an understanding of the human side of T&E alongside 

a supporting strategy. With travel, people often spend time away from loved 

RQHV�DQG�PRQH\�RXW�RI�WKHLU�RZQ�SRFNHW��VR�VKRXOGQ·W�EH�IXUWKHU�EXUGHQHG�ZLWK�

complex policies. Company culture can also have an effect on compliance, as 

ZLWKRXW�SURSHU�SROLFLQJ��LW·V�RQO\�QDWXUDO�WR�WHVW�WKH�ERXQGDULHV��7DNH�PLOHDJH�IRU�

instance. It can account for the vast majority of your T&E spend, yet also be the 

WULFNLHVW�WR�WUDFN��7KDW�PDNHV�LW�DQ�HDV\�WDUJHW�IRU�H[SHQVH�´SDGGLQJµ��$GYDQFHG�

tools can automatically track and create mileage claims to ensure their accuracy 

and alert people when an expense is out of policy. So, what should businesses 

do? Firstly, they must understand the existing corporate culture and enable 

positive change by encouraging and enforcing the right kind of behaviour. 

Secondly, they should use technology to understand whether people are 

complying with policy, making it easier for people to submit expenses correctly.  

Q How do you tackle external compliance?      

A +05&�KDV�FOHDU�GHÀQLWLRQV�RI�ZKDW�D�EXVLQHVV�H[SHQVH�LV��ZKDW�FRQVWLWXWHV�

EXVLQHVV�WUDYHO��DQG�ZKHQ�DQ�H[SHQVH�EHFRPHV�D�´EHQHÀW�LQ�NLQGµ��DORQJ�

ZLWK�GLIIHULQJ�OHYHOV�RI�9$7�RQ�H[SHQVHV��,W�FDQ�EH�FRPSOH[�IRU�ÀQDQFH�WR�

memorise and apply all the rules, ensuring compliance along the way. Expense 

management tools can therefore help minimise risks around regulatory 

FRPSOLDQFH�DV�WKH\�DXWRPDWLFDOO\�DSSO\�WD[�UXOHV��VR�\RXU�WHDP�GRHVQ·W�KDYH�WR�

remember them all. VAT is worked out for each expense type so you can reclaim 

the correct amount of tax without falling foul of legislation. 

Q What should the tech solution include?       

A There are many providers of expense tech out there, so look for a few key 

things: use a cloud-based mobile solution; use something that integrates credit 

cards and supplier feeds; use a system that includes a mileage tracker; ensure 

reporting and visibility capabilities are built in; and ensure that data security and 

*'35�DGKHUHQFH�LV�DFFRXQWHG�IRU�

Dafydd Llewellyn 

Cracking expense compliance

Q  What exactly is meant by expense compliance?    

Q  How do you tackle internal compliance?  Q  How do you tackle internal compliance?  
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Q  What should the tech solution include?        Q  What should the tech solution include?        





SPONSORED REPORT

KDQGOHG�LI�DQ�DVVRFLDWH�WDFNV�RQ�D�IHZ�SHUVRQDO�GD\V�ZLOO�

JR�D�ORQJ�ZD\�WRZDUGV�DVVXULQJ�WKH�FRPSDQ\�LVQ·W�SD\LQJ�

IRU�VRPHRQH·V�EHDFKVLGH�YLOOD�VWD\��

Avoid exceptions

2QFH�\RX·YH�JRW�WKDW�SROLF\�LQ�SODFH��IROORZ�LW��7RR�PDQ\�

FRPSDQLHV�ÀQG�WKHPVHOYHV�LQ�WURXEOH�ZKHQ�WKH\�JLYH�

RQH�VWDIIHU�UHVSLWH�IURP�WKH�SROLF\�DQG�ÀQG�WKDW�HLWKHU�

WKDW�SHUVRQ�RU�RWKHU�VWDII�KDYH�FRQWLQXHG�WR�GHYLDWH�

IURP�WKH�FRPSDQ\·V�UXOHV��$QGHUVRQ�VDLG��+H�JDYH�

WKH�H[DPSOH�RI�D�UHJLRQDO�PDQDJHU�JHWWLQJ�SHUPLVVLRQ�

WR�Á\�EXVLQHVV�FODVV�GHVSLWH�D�UXOH�DJDLQVW�LW��2IWHQ��

WKDW�PDQDJHU·V�FRKRUWV�ZLOO�EHJLQ�VHHNLQJ�WKH�VDPH�

DOORZDQFHV��´$V�VRRQ�DV�\RX�KDYH�VRPHRQH�JUDQWHG�DQ�

H[FHSWLRQ�WR�VRPH�NLQG�RI�UXOH��VRPHKRZ�HYHU\RQH�HOVH�

ÀQGV�RXW�DERXW�WKDW�DQG�VWDUWV�WDNLQJ�DGYDQWDJH�RI�WKLV�

UXOH�µ�$QGHUVRQ�VDLG��:KLOH�WKHUH�ZLOO��RI�FRXUVH��EH�YDOLG�

H[FHSWLRQV�WR�DQ\�UXOH��PDNH�VXUH�DQ\�GHYLDWLRQ�IURP�

SROLF\�LV�ZHOO�GRFXPHQWHG�DQG�KDV�JRQH�WKURXJK�WKH�

SURSHU�FKDQQHOV�IRU�DSSURYDO��

Set the tone up top

2QH�RI�WKH�PRVW�LPSRUWDQW�WKLQJV�FRPSDQ\�H[HFXWLYHV�

FDQ�GR�WR�HQVXUH�FRPSOLDQFH�ZLWK�WUDYHO�DQG�H[SHQVH�

UXOHV�LV�WR�VHW�WKH�H[SHFWDWLRQ�WKDW�SROLFLHV�EH�IROORZHG��

´,I�WKH\�GRQ·W�FDUH��WKHUH�LV�QR�SROLF\�RU�LQWHUQDO�FRQWURO�

WKDW�ZRXOG�SUHYHQW�IUDXG�µ�/RFDWL�VDLG��7KDW�PHDQV�LI�WRS�

PDQDJHUV�DUH�UHTXLUHG�WR�KDYH�WKHLU�H[SHQVHV�DSSURYHG��

PDNH�VXUH�WKDW�KDSSHQV�WR�WKHP�LQ�WKH�VDPH�PDQQHU�

DV�IRU�WKRVH�ORZHU�GRZQ�LQ�WKH�RUJDQLVDWLRQ��&RUSRUDWH�

ERDUGV�FDQ�DOVR�JHW�LQYROYHG�E\�UHJXODUO\�UHYLHZLQJ�WKH�

H[SHQVH�DFFRXQWV�RI�&(2V�DQG�RWKHU�WRS�OHDGHUV��

Have ways to report violations

,W·V�LPSRUWDQW�WR�KDYH�D�ZHOO�DGYHUWLVHG�DYHQXH�WR�UHSRUW�

GHYLDWLRQV�IURP�SROLF\��/RFDWL�VDLG��7KDW�PD\�RFFXU�

WKURXJK�DQRQ\PRXV�KRWOLQHV�HPSOR\HHV�FDQ�FDOO�WR�SDVV�

RQ�WLSV�WR�H[SHULHQFHG�WKLUG�SDUW\�JURXSV��RU�DQ�LQ�KRXVH�

V\VWHP�WR�JDWKHU�FRQFHUQV�DERXW�VXVSLFLRQ�RI�IUDXGXOHQW�

EHKDYLRXU��)RU�H[DPSOH��WKHUH�PD\�EH�D�ZLGHVSUHDG�

SUDFWLFH�LQ�D�UHJLRQDO�RIÀFH�WR�SDG�H[SHQVH�UHSRUWV�WKDW�

JRHV�XQQRWLFHG�DW�KHDGTXDUWHUV�XQWLO�D�YDOLG�WLS�FRPHV�

LQ�WR�FRUSRUDWH�RIÀFLDOV��´6RPHWLPHV�LQ�FRPSDQLHV��

HYHU\ERG\�NQRZV�EXW�QRERG\�VD\V�DQ\WKLQJ�µ�/RFDWL�VDLG��

FINDING TRAVEL SUPPLIERS

0DQ\�IDFWRUV�PXVW�EH�WDNHQ�LQWR�DFFRXQW�ZKHQ�FKRRVLQJ�

D�WUDYHO�PDQDJHPHQW�FRPSDQ\�RU�D�SDUWLFXODU�YHQGRU��

7DWH�VDLG��$QG�WKHUH·V�QR�VKRUWDJH�RI�RSWLRQV�IRU�WKRVH�

LQ�WKH�PDUNHW��+H�VXJJHVWHG�WKRVH�PDNLQJ�WKH�GHFLVLRQ�

KDYH�D�VWURQJ�XQGHUVWDQGLQJ�RI�ZKDW�WKH\�ZDQW��,W·V�

OLNHO\�QRW�MXVW�VDYLQJV��DQG�WKHUH·V�DQ�LPSRUWDQW�EDODQFH�

EHWZHHQ�HQVXULQJ�WUDYHOOLQJ�HPSOR\HHV�DUH�FRPIRUWDEOH�

DQG�DEOH�WR�SHUIRUP�DW�WKHLU�EHVW�DQG�ÀQGLQJ�WKH�ORZHVW�

FRVW�RSWLRQV��,W�KHOSV�WR�JR�LQ�NQRZLQJ�ZKDW�\RXU�RZQ�

WUHQGV�DUH�³�ZKDW�DLUOLQHV�JHW�PRVW�RI�\RXU�PRQH\��

ZKDW�UHVWDXUDQWV�DUH�IUHTXHQWHG�E\�VWDII�IRU�ZRUN�UHODWHG�

PHDOV��DQG�ZKDW�SDUWLFXODU�QHHGV�\RXU�VWDII�KDV��

,W�PD\�QRW�PDNH�VHQVH�WR�IRUFH�D�WRS�VDOHV�SHUVRQ�

WR�VLW�LQ�DQ�HFRQRP\�VHDW�IRU�D�ORQJ�LQWHUQDWLRQDO�WULS�

ZKHUH�VKH·OO�EH�PHHWLQJ�ZLWK�LPSRUWDQW�FOLHQWV�VRRQ�DIWHU�

ODQGLQJ��,QVWHDG��WKH�H[WUD�FRVW�RI�SXWWLQJ�KHU�LQ�EXVLQHVV�

FODVV�VR�VKH�FDQ�JHW�QHHGHG�UHVW�RU�ZRUN�XQHQFXPEHUHG�

PD\�EHWWHU�ÀW�WKH�FRPSDQ\·V�QHHGV��´<RX�QHJRWLDWH�WR�JHW�

WKH�EHVW�KLW�µ�KH�VDLG����Q
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2019 elections to CIMA Council

Newly elected members

T
he following members have been 

elected for their �rst term as 

Members of Council, to serve from 

the close of the Annual General 

Meeting on 7 June 2019 until the 

close of the Annual General Meeting 

in 2022: 

Suresh Perera — South Asia  

 constituency (EC14)

Paul Wilhelmij — Europe, North Africa, 

and Middle East constituency (EC17) 

Stephen Milne — Scotland constituency 

(EC7) — has been elected for his �rst 

term as a Member of Council, to 

serve from January 2019 to the close 

of the Annual General Meeting  

in 2020.

Re-elected members
The following members have been 

re-elected to serve for another term on 

Council from the close of the Annual 

General Meeting on 7 June 2019 until the 

close of the Annual General Meeting in 

2022:

James Owen — Central London and North  

Thames constituency (EC1)

David Johnson — South West England and 

South Wales constituency (EC2)

Michael Lowney — East Midlands and 

East Anglia constituency (EC3)

Nicholas Jessett — West Midlands 

constituency (EC4)

Nick Davison — North East England 

constituency (EC5)

John Graham — North West England and 

North Wales constituency (EC6)

Patrick Barr — Northern Ireland 

constituency (EC8)

Louise Connaughton — Republic of 

Ireland constituency (EC9)

Stuart Wayment — Central Southern 

England constituency (EC11)

Aidan Goddard — North Asia 

constituency (EC15)

Francis Chan — South East Asia 

constituency (EC16)

Martin Saxton — The Americas 

constituency (EC18)

Yolanda Don-Pierrot — East, West 

Central, and Southern Africa 

constituency (EC10) — has been 

re-elected to serve for another term 

on Council from the close of the 

Annual General Meeting on 7 June 

2019 until the close of the Annual 

General Meeting in 2020.

The A to E of 	nance 

F
inance professionals need to be digitally agile. In the 

Association’s Future of Finance research, the immediate 

need for members to acquire new competencies emerged as a 

main theme. 

The “A to E” of �nance — automation, blockchain, 

cybersecurity, data, and everything else that surrounds them 

— are rede�ning today’s businesses. To help CIMA members 

grapple with rapid digitisation and navigate the future of 

�nance, paid and free CGMA learning, research, and other 

resources are available at tinyurl.com/y4tm5dau.
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Start logging your  

CPD now

P
lease familiarise yourself with the Competency and 

Learning website and start logging your CPD now. This will 

make it easier for you to keep track of your achievements and 

submit your record to CIMA when requested.

CPD will remain output-based and continue to place an 

emphasis on the bene�ts of each activity. By using the 

Competency and Learning website, you can be sure that you are 

completing the six steps of the CIMA Professional Development 

Cycle.

Download the guide to using the Competency and Learning 

website at tinyurl.com/y2gqgecr or visit the Competency and 

Learning website at competency.cgma.org.

If you have any queries, please contact cima.contact@ 

aicpa-cima.com.
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CIMA India 

wins 2 

education 

awards

C
IMA India won two 

awards in Mumbai in 

mid-February. First, in The 

Innovative Education 

Leadership Awards it won the 

Best Global Institute for 

Accounting and Finance 

award. It also was the winner 

of the Excellence in 

Accounting and Finance 

Education award, presented 

during the Making of 

Developed India conference.

UK anti-money laundering guidance 

A
ccountants are key gatekeepers for the �nancial system, facilitating vital 

transactions that underpin the UK economy. They have a signi�cant role to play in 

ensuring their services are not used to further a criminal purpose. As professionals, 

accountants must act with integrity and uphold the law, and they must not engage in 

criminal activity. 

Anti-Money Laundering Guidance for the Accountancy Sector, available at tinyurl.com/

ybz6j36s, is a key document by the Consultative Committee of Accountancy Bodies, 

which provides guidance based on the law and The Money Laundering, Terrorist 

Financing and Transfer of Funds (Information on the Payer) Regulations 2017. It covers 

the prevention of money laundering and the countering of terrorist �nancing. It is 

intended to be read by anyone who provides audit, accountancy, tax advisory, 

insolvency, or trust and company services in the UK and has been approved and 

adopted by the UK accountancy anti-money laundering supervisory bodies.

CPD monitoring

A
s a member and quali�ed 

professional, you are required to 

undertake CIMA Professional 

Development. CIMA’s CPD scheme 

provides a framework to help you 

consider your learning needs, develop a 

plan to meet your professional 

development goals, and re�ect upon your 

achievements.

If you are selected to submit your CPD 

record to CIMA for monitoring, you will 

be required to do so using the 

Competency and Learning website at 

competency.cgma.org. CPD submissions 

by any other method will not be accepted.

If your employer is part of CIMA’s 

accreditation scheme, you will not be 

required to submit your record. However, 

if you are selected for monitoring, please 

get in touch with the CPD monitoring 

team to con�rm your status.

CIMA president’s visit to Africa

C
IMA president Steven Swientozielskyj made a one-week visit to Africa in March. His �rst stop 

was Botswana, where meetings included one with the country’s �rst lady, Neo Masisi, FCMA, 

CGMA, for a wide-ranging discussion.

In Zambia, in addition to meeting CIMA members and Association employees, the CIMA 

president visited the Zambia Institute of 

Chartered Accountants (ZICA), which, he 

said, was about “developing cordial 

relationships”.

He added: “Africa as a continent is an 

amazing and dynamic place — full of energy 

and enthusiasm for the future.”

In South Africa he spoke at a CIMA gala 

dinner in Sandton in the northern province 

of Gauteng. In Pretoria he was the keynote 

speaker at the CIMA Gauteng graduation 

with more than 300 graduates and their 

guests.

Talking to members and students at 

events during the visit, Swientozielskyj 

focused on CIMA’s 100-year celebration, 

digitisation, and the CIMA quali�cation,  

and how to remain employable in  

the future.
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CIMA president Steven Swientozielskyj with a 
Diploma in Management Accounting graduate 
in Gauteng, South Africa.
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hree-dimensional printing holds promise 

for a manufacturing industry that will 

operate “on demand” and reduce the need 

for warehouses and distribution centres to 

store and ship parts. This is because 3D 

printing can print the whole product instead of the 

alternative of producing parts and assembling them.

That said, experts say 3D printing will not replace 

traditional manufacturing in the foreseeable future 

because it’s still more expensive and slower than 

traditional techniques of casting, forging, stamping, 

and moulding that have been used for centuries. The 

opportunity for 3D printing is not in cost savings but in 

production of highly customised products.

In healthcare, 98% of hearing aids worldwide are 

now 3D-printed, according to a report by Wohlers 

Associates, and crafted to fit each user’s unique ear 

shape. In 2017, athletic apparel company adidas started 

selling 3D-printed shoes to elite athletes based on their 

performance data.

— By Alexis See Tho (Alexis.SeeTho@aicpa-cima.com), 

an FM magazine associate editor.

On-demand

customisation

Grecia the toucan, who lost 
most of his upper beak in 
an attack, eats with his new 
3D-printed beak at Zoo 
Ave animal sanctuary in 
Alajuela, Costa Rica.



Do you wonder about the best way 
to build your personal brand? Are 
you hoping to assume a leadership 
role but unsure about how to 
become a better leader? Listen to 
insights from a global collection of 
finance leaders and other experts 
in the FM magazine podcast.

P O D C A S T S

Stream episodes at  
fm-magazine.com/podcast  
or subscribe on iTunes or 
Google Play.
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